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Welcome

The Commodore®Amiga® line of personal computers offers a unique
combination of versatility, computing power, and usability.

The Amiga's Workbench™" Graphical User Interface (GUI) allows
you to control the Amiga by using a mouse to select graphic symbols
in the form of icons, or small pictures, and list-like menus. The
Workbench is easy to learn and use because these icons and menus
are displayed automatically. You do not have to memorize a long
list of commands to accomplish a task.

Multitasking is the ability of the Amiga to run several independent
programs at one time. Because the Amiga was designed from the
start as a multitasking system with a GUI, it is fast and easy to
switch between tasks (programs) when you need to. Not only can
programs run at the same time on the Amiga, but they can also
share information and computer resources, allowing you to do more
work without requiring additional software and memory.

The Workbench and multitasking are features common to all
Amigas, from the single floppy models to the most advanced
workstation-level machines that are used for three-dimensional
graphics, multimedia, and video production.

This manual describes the Amiga Workbench software, its
components, and how to use it.
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Using This Manual

This manual provides operational instructions and reference
material for using your Amiga Workbench. If you have never used
an Amiga before, read the entire manual to become familiar with
the general operations of your Amiga and the Workbench system.
Once you learn the basics, this document can serve as a reference
tool. If you are already familiar with the Amiga, be sure to read
through the manual for new information that you may not know.

Chapter 1. Before You Start: This chapter provides instructions
for things you need to do and information you need to know before
you start using your Amiga, including installation procedures.

Chapter 2. Basic Operations: This chapter describes starting
your Amiga, creating and managing disks and files, and using your
mouse and keyboard.

Chapter 3. Fundamentals of Workbench: This chapter
describes the elements that comprise the Workbench environment,
including screens, windows, menus, icons, gadgets, and requesters.

Chapter 4. Workbench: This chapter provides an overview of the
Amiga Workbench system, including descriptions of the Workbench
programs and the environment.

Chapter 5. Preferences: This chapter details the information
needed to set your Amiga to work with monitors, printers, and other
peripherals and how to "customize” your individual Workbench
environment.

Chapter 6. Localization: This chapter describes the localization
options available on the Amiga Workbench including language,
date, time and numeric format.

Chapter 7. CrossDOS: This chapter describes CrossDOS, which
allows you to read and write MS-DOS formatted disks on your
Amiga.

Chapter 8. Fonts: This chapter explains how to install and use
both bitmap and outline fonts on the Amiga.
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Chapter 9. Printers: This chapter describes printers and printer
options for producing the output that best suits your needs and
equipment.

Chapter 10. Other Amiga Programs: This chapter explains the
programs in the Tools and Commodities drawers.

Chapter 11. ED Editor: This chapter explains how to use the ED
text editor to create and edit text files.

Appendix A. Troubleshooting: This appendix provides solutions
to common problems that can occur.

Appendix B. Screen Display Modes: This appendix provides a
listing of monitor display modes that can be used with your Amiga.

Appendix C. Special Boot Menu Options: This appendix
provides information on special boot options.

Documentation Conventions

The following conventions are used in this manual:

KEYWORDS Keywords are displayed in all uppercase letters,
however, the arguments are not case-sensitive.

<n> Angle brackets enclose variable information that you
must supply. In place of <n>, substitute the value,
text, or option desired. Do not enter the angle
brackets when entering the variable.

Courier Text appearing in the Courier font represents
information displayed on your screen.

Keyl + Key2 Key combinations displayed with a + (plus) sign
connecting them indicate pressing the keys
simultaneously. For example, to open an icon, hold
down the Right Amiga key and, while holding it
down, press O.
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Keyl, Key2  Key combinations displayed with a comma
separating them indicate pressing the keys in
sequence. For example, to open a file in ED, press
the Esc key, followed by the O key, and then
followed by the P key.

Amiga keys  Two keys on the Amiga keyboard used for special
functions. The left Amiga key is to the left of the
space bar and is marked with a large solid A. The
right Amiga key is to the right of the space bar and
is an outlined A.

Related Documentation

AmigaDOS™ User's Guide
ARexx User’s Guide



Chapter 1
Before You Stari

Before you start using your Amiga, there are a few things you
should know and must do. This chapter provides you with
instructions for:

o Choosing a language for processing

o Installing the complete Workbench software
o Installing languages

o Getting started

Choosing a Language for
Processing

If you wish to interact with the Workbench in any language other
than English, you must select your preferred language after you
initially boot the system or following successful software
installation. We recommend that you load all of the languages that
you may want to use for processing during the installation.
However, if your language is not available, you can install it at a
later time. For instructions on selecting a language for Amiga
Workbench processing, see Chapter 6 in this manual.
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Software Installation

If your Amiga has a hard disk, you must install software on it:

« if your system is not preloaded.
o if you have a software upgrade.
o if you reformat your hard disk.

Workbench software comes preinstalled on most Amiga hard drive
models. If you are not certain your system is preloaded, consult
your dealer.

Once your software is installed, if your system does not have all the
languages that you want to use, you can install any of them without
running a full installation.

Installing System Software

The following procedures describe how to install your system
software:

1. Insert the Amiga Install disk into any floppy disk drive.
2. Boot your system (turn it off and on again).

3. Moving your mouse on a flat surface, place the tip of the pointer
onto the icon labelled Install and quickly press (click) the left
mouse button twice. A window containing drawer icons is
displayed on the screen.

4. Using your mouse, move the tip of the pointer onto the icon for
the Install drawer and quickly press the left mouse button
twice. A window containing icons representing the various
languages is displayed on the screen.
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10.

11.

Using your mouse, move the tip of the pointer onto the icon for
the language that you want to use for the installation and
quickly press the left mouse button twice. This selects a
language for the installation process only.

If you choose any language other than English, a message
asking you to insert the Locale disk is displayed. Remove the
Install disk from the floppy disk drive and insert the Locale
disk. A message prompts you to reinsert the Install disk after
Locale has been read. Clicking on the Help button displays help
in your chosen language.

Select an installation mode from the Install window by clicking
the left mouse button once on the button to the left of your
choice. Then click the left mouse button once on the Proceed
With Install button.

The next screen asks you if you wish to install the complete
software or update the languages available on your system.
Press the left mouse button once on your choice.

The next screen asks you if you wish to install your software in
the System drawer. Press the left mouse button once on Yes to
install to the default drawer or press the left mouse button once
on No to make your own choice.

The Installer starts loading the software from the disks. Follow
the instructions on the screen, inserting disks as requested.

When you are asked to select printer drivers,languages, and
keymaps to be installed, click once on each corresponding box to
make your selections and then click once on the Proceed button.

When the Installation is complete, remove the Install floppy,
and reboot your system. Select Proceed to reboot or manually
reboot.

To use Workbench in any language other than English, you
must select your preferred language in the Locale Preferences
Editor. See Chapter 6 for instructions and information on
choosing a language for processing.



1-4 Installing System Software

Getting Started

Once your software, printer drivers, and languages are all loaded
and selected, if you have never used an Amiga before, it is helpful to
read through this manual, concentrating on Chapters 2 through 4 to
learn basic operational information about the Amiga and the
Workbench.

The following table indicates where yoﬁ would find information to
do the following tasks:

Task Where to find it
Booting/rebooting your system Chapter 2
Using your mouse Chapter 2
Managing disks and files Chapter 2
Learning the parts of the Workbench  Chapter 3
Making backup copies Chapter 3
Formatting disks Chapter 3
Using Workbench Chapter 4
Opening a Shell window Chapter 4
Customizing Workbench Chapter 5
Localizing your Workbench Chapter 6
environment

Using CrossDOS Chapter 7
Choosing fonts Chapter 8
Setting up printers and printing Chapter 9
Using Workbench tools Chapter 10
Text editing Chapter 11
Trouble shooting Appendix A
Choosing a display mode Appendix B

Freeing memory for large games Appendix C



Chapter 2
Basic Operations

Before using your Amiga, you should familiarize yourself with the
basic Amiga system concepts and techniques provided in this
chapter. These include:

» Booting your system

» Using the mouse

o Handling disks and using disk drives

« Creating and accessing files and directories

Booting/Rebooting Your System

Booting powers on your computer and loads the operating system
information from a disk to the computer's memory. Each time the
Amiga is booted, the system must find the Amiga system software
on a bootable hard disk or floppy disk inserted into a disk drive. If
there are no bootable disks when the system is powered on, an
animated screen requests that you insert a bootable disk into a
floppy drive.

Rebooting resets your computer without turning off the power. This
process terminates any active programs and removes any data
stored in the Amiga's memory.

Each time the Amiga is booted or rebooted, the following events
occur:

1. The Amiga executes a script file called the Startup-sequence.

2. The Startup-sequence executes a file called User-startup, if it
exists.

3. The Amiga Wbrkbench screen appears.
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4. Workbench runs any programs whose icons are in the
WBStartup drawer.

The Startup-sequence file contains AmigaDOS commands that load
the Amiga software and handle various hardware and software
setup tasks. Do not alter this file; altering the Startup-sequence file
can prevent the Amiga from booting properly. If you want to
customize your system configuration, you can create a User-startup
file that loads when the system is booted or rebooted. You can also
customize you system startup by placing program icons in the
WBStartup drawer. This automatically starts these programs when
you boot or reboot.

To reboot your system:

1. Be sure that all disk activity has stopped and that all floppy disk
drive and hard disk drive lights are unlit.

2. If you are rebooting from a floppy disk drive, insert a copy of the
Workbench disk into a floppy disk drive.

3. Simultaneously hold down the Ctrl (Control), left Amiga, and
right Amiga keys and then release them.

The Workbench screen illustrated in Figure 2-1 appears following a
successful reboot.

fAmiga Workbench 2,039,848 graphics mem 1,152,864 other men E]

Figure 2-1. Workbench Screen
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Special Boot Optiohs

Extra memory used for maintaining devices can cause floppy-based
games from running. See Appendix C for information about how to

avoid this problem.

Using the Mouse

The Amiga comes equipped with a mouse, illustrated in Figure 2-2,
used to communicate with the system through the pointer. The
pointer is an image of an arrow on your screen that is manipulated
by moving the mouse. Positioning the mouse so that the pointer is
located on an icon, window, menu, or screen and pressing the mouse
buttons tells the Amiga what to do.

mouse

selection
button

Figure 2-2. Amiga Mouse

Moving the Mouse

Hold the mouse on a flat surface with the cable extending away
from you so that the mouse box rests under the palm of your hand
with the buttons under your fingertips. The button on the left is the
selection button and the button on the right is the menu button.
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When using the mouse,

Pointing means moving the mouse so that the tip of the
pointer is positioned over an object on the screen.
The pointer moves in the same direction you move
the mouse. The mouse can be lifted and
repositioned at any time. Lifting the mouse does
not move the pointer.

Clicking means pressing and releasing the selection button.

Double-Clicking imeans clicking the selection button twice in rapid
succession. Double-clicking on an icon causes a
window to appear or a program to start.

Holding Down means pressing the mouse button until your action
is completed.

Dragging means moving screens, windows, and icons by
holding down the selection button and moving the
mouse.

Selection Button

The left mouse button is the sclection button, used for selecting
screens, windows, and icons for processing. This button is also used
to move, or drag, iters on the screen.

Each of these mouse techniques is described in the following
sections.

Selecting an Icon or Window

Windows are rectangular areas on the screen that can accept or
display information. Icons are images in windows that represent
disks, drawers, projects, or tools.

To work with an icon or window you must first select it. Once an
icon is selected, you can make a copy of it, change its name, or
delete it.
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All icons are surrounded by a box. When an icon is not selected, the
box appears raised above the screen or window surface. When you
select an icon, the box appears to sink into the screen or window
surface. Icons also change color or shape when selected. For
example, drawer icons change from a closed drawer to an open
drawer when selected.

To select an icon:

1. Point to the icon, making sure the pointer tip is within the icon's
box.

2. Click the selection button. The icon changes to show that it is
selected.

If you click the selection button while the pointer is elsewhere on
the screen or window, the icon is deselected and returns to its
original appearance.

Select a window by clicking the selection button while the poinier i3
inside the window, but not over an icon.

When a window is selected, the frame surrounding the window
changes color. Only one window can be selected at a time. The
selected window is the one that accepts your mouse and keyboard
input.

Selecting Multiple Icons

You can select several icons at one time. When multiple icons are
_selected, you can treat them as a single entity, deleting, moving, or
copying the entire group in one operation.

The two methods for selecting multiple icons using the mouse are
drag selection and extended selection.

Drag selection uses the mouse to draw a box around all of the icons
that you wish to select, as follows:

1. Move the pointer just outside of the outermost icon to be
included in the box. That point is one corner of the box. Make
sure it is not on an icon or gadget.

2. Hold down the selection button and move the mouse to draw a
dotted box as it moves.
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3. When the box encloses all the icons to be selected, release the
mouse button. All of these icons are now selected.

The extended selection method is for selecting icons that are not in
a group that can be enclosed in a box, as follows:

1. Select the first icon.

2. Hold down Shift.

3. While holding down Shift, select each of the other icons.
4

Release Shift. All of the chosen icons remain selected until you
select a different icon or click within a Workbench window while
not holding down Shift.

Opening a Window

Double-clicking on an icon opens a window or starts a program.
Adjust the time allotted for a double-click with the Input
Preferences editor, explained in Chapter 5.

Dragging an Icon
To drag an icon:
1. Point to the icon.

2. Hold down the selection button and move the mouse. An image
of the selected icon moves with the pointer.

3. Release the selection button when the icon is in position.

If you selected several icons, you can drag all of them at once. Hold
down Shift, point to one of the icons, hold down the selection button,
and move the mouse. All the selected icons move as you move the
mouse.

Dragging a Window

When several windows are open on the Workbench screen, they
may overlap each other. Rearrange the windows on the screen by
dragging them, to show the information presented in all the
windows.
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To drag a window:

1. Point to the title bar, but make sure the pointer is not over any
of the gadgets at either end.

2. Hold down the selection button and move the mouse. An outline
of the window appears and moves across the screen.

3. Drag the outline into position and then release the selection
button. The window appears in the new location.

Dragging a Screen

Screens are areas of the display on which windows are opened. It is
possible to have more than one screen open at a time. If your
Workbench screen, a terminal program screen, and a text editor
screen are open all at the same time, you can see parts of each
screen by dragging them into view.

To drag a screen:

1. Point to the screen's title bar.
2. Hold down the selection button.
3. Move the mouse down.

To expose a screen, you can drag any screens that are in front of it
down. If a screen is larger than a monitor's display area, you can
drag it up or down or side to side so that you can see all areas of the
screen.

To drag a screen when its title bar is covered by windows or not on
the visible part of the display, hold down the left Amiga key and
then the selection button. This lets you "grab” the screen and drag
it, regardless of the mouse pointer position.

Copy by Dragging

Copy a drawer, project, or tool to another disk by dragging the icon
over the other disk's icon or into the other disk's window. The
original icon stays on the original disk and a copy is created in the
destination disk's window.
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You cannot make a copy of an icon on the same disk with this
method. To copy something onto the same disk, select its icon, and
then use the Copy menu item. For more information, see the menus
discussion in Chapter 3.

You can copy several icons at once using drag selection or extended
selecticn. When the icons to be copied are selected:

1. Hold down Shift.

2. Point to one of the selected icons and then drag it over the other
disk's icon or into the other disk's window. As you drag one
icon, the rest follow.

3. Release the selection button to copy the icons.

Note When drag-copying several icons, be sure the tip of the
pointer is over the icon or window to which you are
copying when you release the selection button.

Wenu Button

The right mouse button is the menu button, which is used to display
the menu bar and menus and to choose items from them. Menu
bars appear across the top of the screen, containing any menu
headings available. The menu button can also be used to cancel
operations being performed by the selection button, such as drag
selection.

Cancelling an Operation

Cancel the operation being performed with the selection button by
clicking the menu button while still holding down the selection
button. The following operations can be cancelled: selecting,
dragging, drag selection, and changing the size of a window.

Cancel selection of button-type gadgets by moving the pointer off
the gadget button before releasing the selection button.
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Using the Amiga Without a Mouse

All mouse actions can also be done using the keyboard. Certain key
combinations allow use of the keyboard to move the pointer, select
icons, and choose menu items. Keyboard shortcuts appear in the
menu boxes for some options. For a full description of these key
functions, see the hardware manual for your Amiga model.

Using Disk Drives

Disk drives are devices from which information is retrieved or to
which information is written or stored. An Amiga can have one or
more hard disk drives, as well as floppy disk drives, depending on
the model. Each disk drive has a device s.ame, such as DFO: for the
internal floppy drive. (Additional floppy drives are designated DF'1:,
DF2:, and DF3:.) A disk icon is displayed on the Workbench screen
for each disk inserted in a drive and for each hard disk partition.

The device name and the volume name are two ways of identifying a
given disk. For most purposes use either name to refer to the disk
when entering a path or within a file requester. Although the
device name is generally shorter and faster to enter, the volume
name is more specific. For example, if you have a floppy disk in
device DF0: with a volume name of Mydisk, you can reference it as
either DFO: or Mydisk:. If you reference Mydisk: and it is not
currently in JFO0:, the Amiga asks you to insert Mydisk in any
drive.

Each drive has an indicator light tnat is lit when the device is in
use, either reading or writing data.

Caution  Never reboot or turn off your Amiga when any of the
disk lights are lit or you risk damaging the drive
and/or the files on the disk.

Never remove a floppy disk from a floppy disk drive
when the light is lit or you risk damaging the drive
and/or the files on the disk.
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Inserting Floppy Disks

The standard 3.5-inch floppy disk can be inserted only one way.
Insert the disk into the disk drive with the label side facing up and
the metal end with the indicator arrow entering first.

Using Floppy Disks

Floppy disks must be write-enabled and formatted before
information can be written on them. To write-enable a floppy disk,
turn the disk to its back side and push the plastic tab in the upper
left corner down to cover the hole. Conversely, to write-protect a
floppy disk, push the plastic tab up, uncovering the hole. Figure 2-3
illustrates the write-enable/protect tab on a floppy disk. Formatting
floppy disks is described in Chapter 3.

write-protected

write-enabled

N

Figure 2-3. Write Protecting/Enabling Floppy Disks.
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The disk from which information is copied is referred to as the
source disk (FROM disk). The disk to which the information is
copied is referred to as the destination disk (TO disk). The source
disk should always be write-protected to avoid accidental erasure.
The destination disk can be a blank disk or a previously used disk
whose contents are no longer needed. This disk must be write-
enabled to accept the information from the source disk.

Using the Ram Disk

The Ram Disk icon represents RAM:, an area of the Amiga's
internal memory that is set up as a file storage device like a disk.
Files, directories, and entire floppy disks (available memory
permitting) can be copied to RAM: for temporary storage. The Ram
Disk serves as a work area that the system can quickly access.

The size of RAM: is dynamic. It is never any larger than necessary
to hold its contents. Therefore, it is always 100% full. Its maximum
size is limited by the amount of free memory.

The primary advantage of RAM: is speed. Since it is electronic
rather than mechanical, storage and retrieval are almost
instantaneous. The disadvantage of RAM: is that data stored in
RAM: does not survive when the computer is powered down or
rebooted. You must save to floppy disk or to hard disk anything in
the Ram Disk that you want to use again.

Applications commonly use RAM: to store temporary files created
when the program runs or for backup files created when the
program is exited. RAM: can also be used as storage for
experimental script files, as a destination for testing command
output, and when the creation of a file on an actual disk is too slow,
risky, or inconvenient.

Be careful when using RAM: for storing important files. If the
Amiga loses power, has a software failure, or you reboot, everything
stored in RAM: is lost. Be sure when working with RAM: to
regularly back up any important files on a floppy disk.
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Note You cannot copy a disk to RAM: by dragging the
source disk icon over the Ram Disk icon. To copy a
disk to RAM:, open the Ram Disk icon and drag the
floppy disk icon into the Ram Disk window. This
creates a drawer with the name and contents of the
floppy disk.

Backup Disks

Backup disks ensure against a loss of data in the event of damage,
corruption, or accidental erasure of the original disk. We
recommend that you make backup copies of important disks and
files, following the licensing agreements provided with your
applications software. Making and distributing unlicensed copies of
disks is a copyright violation known as software piracy. Store your
original disks in a safe place and use your backup disks for
everyday purposes.

Managing Your Files

Organizing Information on Disks

Information should be stored on disk in a logical manner to allow
easy access to your files. The Amiga Workbench organizes
information into a hierarchical system of drawers.

A drawer, or a directory in AmigaDOS, is a container for items that
are related. These items can be files and even other drawers.

On any disk you can create multiple drawers containing multiple -
files, as available disk space allows. Workbench also allows the
creation of drawers within drawers, "subdrawers" or subdirectories,
for further file management. Create as many drawers and
"subdrawers" on your disk as needed.
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A drawer icon is displayed in the disk window for each drawer
created on a particular disk. Each drawer window contains the
icons of the files and subdrawers that exist in it.

Paths

A path is a complete description of the location of a particular file on
a disk. When a program requests the name of a file for retrieval,
specify the file's path, including the volume or device name and all
the drawers that lead to that file.

The method for specifying paths varies from program to program.
Most programs use a file requester with a scrolling list, in which the
disk name, any drawer names, and the file name are displayed.
Click on the appropriate names to specify the path. However, for
some programs you may have to type in the complete path name.

To enter a complete path:

1. Type the name of the disk followed by a colon. This name is the
volume name of the disk, such as Mydisk:. You can substitute
the disk's device name, such as DFO:, in place of the disk name.
However, if you enter the device name rather than the volume
name, be sure the correct disk is in that device.

Diskname:

2. For a file that is not in a drawer, specify the file name after the
colon following the disk name.
Diskname: filename

3. For a file in a drawer, after the colon following the disk name

specify the drawer name followed by a slash (/) followed by the
file name.

Diskname:drawername/filename
4. If there are more drawers in the path, each drawer must be
specified followed by a slash.

Diskname:drawername/subdrawername/filename
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Note File and drawer names containing spaces can cause
recognition problems. We recommend that you avoid
using spaces in file or drawer names. If you have
trouble referencing a name that contains a space,
enclose the entire path in double quotation marks.

File and Drawer Names

The following rules apply for naming files and drawers:

o Names can be up to 31 characters long.

o Colons (:) and slashes (/) are not allowed within a name. These
characters are reserved for path statements. However, other
non-alphabetic characters may be used.

o The use of spaces before or after names should be avoided due to
the possibility of confusion.

o Upper and lower case differences (capitalization) are preserved
and displayed by the Amiga. However, the system is case-
insensitive: upper and lower case are considered the same.

« Duplicate file names are not allowed within the same drawer. If
you save a file with the same name as an existing file in a
drawer, it overwrites the original file in that drawer.

« Two files with the same name can exist in separate drawers or
within different paths.

Trashcan

The Trashcan is a special drawer in each volume for storing files
that you no longer need and may wish to delete. Discard icons or
pseudo-icons for the files to be deleted by dragging them into the
Trashcan. If the icon to be discarded is a drawer, its associated files
are also moved to the Trashcan.

Choosing Empty Trash from the Icons menu deletes the icons and
all of their associated files from the Trashcan. Before choosing

~ Empty Trash, you can still recover any of the Trashcan's contents
by opening its window and dragging the icons back out.
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Workbench

This chapter describes the Amiga Workbench, an icon-based
environment that allows you to give instructions by manipulating
graphic symbols with a mouse rather than by typing in commands
at a keyboard. Included in this chapter are descriptions of the
following:

o The Workbench Screen
o The Workbench Window
o The Workbench Menu

o  Workbench Programs

Workbench Screen

The Workbench screen, illustrated in Figure 4-1, is the primary
visual component of your system. Icons and other windows appear
on it.

The Workbench screen is identified by the Amiga Workbench title
bar located along the top border of the display. The Workbench
screen's title bar also displays the number of bytes of graphics

(Chip) memory and other (Fast) memory currently available for any
selected window, except an open Shell window.

The Amiga provides Preferences editors (described in Chapter 5)
that allow you to customize the Workbench screen. You can define
an extra-large "virtual" Workbench screen that is larger than the
viewable area with more space for windows.
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Workbench Window

When you boot your Amiga, the Workbench window fills the
Workbench screen. This window contains icons for any floppy disks
inserted into floppy drives, the Ram Disk, and any other icons
determined by your system's configuration.

Although the Workbench window appears and functions like an
application window, it is an essential part of the Workbench screen.
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Figure 4-1. Workbench Screen

Workbench Menu

The Workbench menu contains general Workbench options and

- options for windows opened on the Workbench screen. You can, for
example, use the Workbench menu to update the screen display or
see which version of the system software is in use.
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On the Workbench menu you can select the following options:

Backdrop AB

The Backdrop menu item creates more room on the Workbench
screen for displaying windows and icons. Backdrop switches
between a normal window for your Workbench and a special
borderless window that is always behind other windows opened on
the Workbench.

Choosing Backdrop removes the Workbench window borders so that
the disk icons appear to be on the Workbench screen without being
enclosed in a window. To return to the normal Workbench window,
choose Backdrop again. Backdrop is reset to off if you power off or
reboot your computer. To save your Backdrop selection choose the
Snapshot item in the Windows menu.

Execute Command AE
Note This menu item is provided for users familiar with
AmigaDOS.

The Execute Command executes (starts) an AmigaDOS command
without opening a Shell window. Figure 4-2 illustrates an Execute
Command requester.

Enter Command and its ﬂ_rgunents ]

Figure 4-2. Execute Command Window

The command and all of its arguments should be entered in the
requester.
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A Workbench Output Window is automatically opened on the front
of the screen when a command results in output and it remains
there until you select its close gadget. The current directory for an
Execute Command operation is RAM:.

Redraw All

Redraw All redraws all open Workbench windows on the
Workbench screen and may be used in the event of a disturbance to
the Workbench. If Redraw All does not restore the windows to their
proper appearance, reboot the computer.

Update All

Update All reopens each open Workbench window, updating its
appearance to show its current state.

Note If you have several windows open and have been using
the Shell or an application to change to the contents of
a disk, the changes may not be reflected in its windows
until you close the windows and reopen them or choose
Update All.

Last Message

Last Message retrieves the last information or error message that
appeared on the title bar.

About

About opens a requester showing the internal version number of the
Workbench and Kickstart software, as well as copyright
information. Select the OK gadget to close the requester.
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Quit AQ

Quit closes all Workbench operations, making additional RAM
available if needed. The Workbench does not close if there are any
programs running, including programs that do not open a window
~and programs that are in your WBStartup drawer.

The only windows that can remain open while using Quit are the
disk, drawer, and Shell windows. Once you OK the Quit requester,
a Shell window is your only link to the Amiga. You can use the
Shell icon in the System drawer to open a Shell window before
quitting the Workbench.

Return to the Workbench by typing LOADWB (load Workbench) at
the Shell prompt and pressing Return. If there is no Shell window
open, you must reboot to return to the Workbench.

The close gadget on the Workbench window is the same as choosing

Quit.

Workbench Programs

The Workbench disk window contains a number of drawers that
contain system and utility files.

These drawers are:
o System

o Utilities

o Devs/Storage

o WBStartup »
+ Expansion

o Tools

System Drawer

The System drawer contains programs that control system
functions. Some offer access to Amiga accessory programs, such as
AmigaDOS or ARexx.
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FixFonts

FixFonts should be used after fonts are added to or deleted from
your Fonts drawer.

For more information on fonts and FixFonts, see Chapter 8.

Format ﬂl

Format a disk by opening the Format icon. The procedure follows
the same steps as used with the Format Disk menu item, described
in Chapter 3.

Intellifont ;n_”

Intellifont manages the installation of Intellifont® outline fonts onto
your Amiga. Intellifont and fonts are described in Chapter 8.

NoFastMem mji

Some very old programs may not run properly when memory other
than graphics (chip) memory is present in the Amiga system. In
this case, double-clicking on the NoFastMem icon forces the Amiga
to use only the available graphics memory. The "other mem"
display in the Workbench title bar drops to 0 (zero). The icon works
like a toggle switch. To restore expansion (Fast) memory to the
system, double-click on the NoFastMem icon again. NoFastMem
does not open a window.

A |

disrves

RexxMast

RexxMast is the interpreter for the optional ARexx programming
language. To use RexxMast double-click on its icon. To run
RexxMast each time you boot, drag the icon into WBStartup.
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)
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Shell

Shell opens an Amiga Shell window, which gives you complete
access to the AmigaDOS command line environment.

Utilities Drawer

The Utilities drawer contains programs that are helpful, but not
necessary for working with your Amiga.

Clock @Jj

Clock displays the time and date on your Workbench screen. It can
also be used as an alarm clock to signal you at a specified time.

When you open the Clock icon, a window with a round (analog)
clock face appears. If the time shown is incorrect, use the Time
editor.in the Prefs drawer, described in Chapter 5, to set the correct
time.

Clock has two menus for changing the display and settings: Project
and Settings.

The Project menu lets you choose the display mode for Clock or
choose Quit to close the Clock. Analog is the default display mode;
its window size can be changed. Digital, the numeric clock, displays
a digital clock the height of the title bar. (Note that the Digital
clock uses your screen font.).

The Settings menu lets you:

Display the Date Displays the date beneath the analog clock.
The date and time are alternately displayed on
the digital clock. Date off is the default.

Display Seconds Displays the time with a sweep second hand
on the analog clock. The default setting
shows no seconds. The Display Seconds item
is not available on the digital clock.
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Display a 24-Hour Clock Displays the time in a 12 or 24 hour format,
with or without seconds, for the digital clock
only.

Set the Alarm Allows you to set the time for the alarm to
signal you. Because the signal is a short
audible tone, you must have audio output on
your Amiga to use this feature.

To set the alarm:
1. Choose the Set Alarm menu item.

2. Change the time setting by dragging the hour and minute
sliders to the right to increase the value or the left to decrease
the value until the correct time is displayed.

3. When the requester displays the desired alarm time, select the
Use gadget. Select the Cancel gadget to restore the previous
alarm setting and exit.

4. Choose the Alarm menu item to turn the alarm on.

The alarm remains on and beeps at the same time each day until
you deselect Alarm or close the Clock. The Clock must be running
for the alarm to work. The next time you open the Clock, the alarm
must be reset.

The Settings menu also lets you save your settings with the Save
Settings item.

Tool Types

Tool Types in the Clock icon's Information window allow you to save
the menu, size, and position settings on the Clock. The acceptable
Tool Types are:

DIGITAL The clock opens in digital mode

24HOUR The clock opens in 24-hour mode

SECONDS The clock displays the seconds

DATE The clock displays the date

LEFT=<n> The clock opens <n> pixels from the left edge of the
screen

TOP= <n> The clock opens <n> pixels from the top of the screen
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WIDTH= <n>

HEIGHT= <n>

FORMAT= <n>

More

The clock is <n> pixels wide (disregarded if using a
digital clock)

The clock is <n> pixels high (disregarded if using a
digital clock)

The digital clock is preset to the specified format; <n>
=0-5.

More displays ASCII files on the Workbench screen.

To move through the More Display, use the following key

sequences:

Space bar
Backspace
Return

<

>

%n

Ctri+L
ftext

text

N

H

Q
Ctrl+C
Shift+E

Displays the next page.
Displays the previous page.
Displays the next line.
Displays the first page.
Displays the last page.

Displays approximately n% into the file; if you enter
%60, you are placed 60% into the file.

Updates the window (this is useful if you have made
the More window larger).

Performs a case-sensitive search for the text specified
after the slash (/).

Performs a case-insensiﬁve search for the text
specified after the period (.) That is, the system
ignores upper and lower case in the search.

Finds the next occurrence of the previously searched
for text.

Help (displays a list similar to this one).
Exits the program.
Exits the program.

Allows you to edit the file using the editor set in
ENV:editor.
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When the last page of the display is reached, an End of File message
is displayed at the bottom of the screen. Press the space bar to exit
More.

More searches for text in any form. A case-insensitive search is one
that searches for the text in upper or lower case. For example, the
words More, MORE, more, and mOre are all the same in a case-
insensitive search. A case-sensitive search is one that searches for
the text exactly as it is entered. If you enter the text in upper case
letters, More only looks for occurrences of the text that appear in
upper case letters.

MultiView ﬁ

MultiView lets you view files, including picture files, text files,
AmigaGuide help files, sound files, and animated graphics files. For
more information on the Data Types used by MultiView, see page
4-15. Figure 4-3 illustrates the MultiView window.

i

: - v
Pattern [¥? =
™ Draver [ 2l
File | i
(Open | Volumes| Parent | Cancel |
R R e A

Figure 4-3. MultiView Window

Load files into MultiView using the file requester provided or drag
icons onto MultiView. The following gadgets appear on the
MultiView file requester:
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Pattern Searches for a file pattern

Drawer Displays the drawer of the selected file

File Displays the filename of the selected file

Open Opens the selected file

Volumes Displays the available volumes from which to select a
file

Parent Returns to the parent directory of the file or directory
last viewed

Cancel Cancels MultiView without opening a file

Move through the file you are viewing using the window gadgets,
scroll bars, and sliders on the display window.

MultiView has four menus: Project, Edit, Windows, and Settings.

Project Menu

Open Opens a MultiView file requester.

Save As Saves object as ILBM or text files.

Print Prints selected blocks or files.

About Shows the MultiView release information and the type
of document being viewed.

Quit Quits Mulitview.

Edit

Mark Turns on the block selection cursor and lets you select
a block. (This is only available for picture files.)

Copy Copies selected block to the Clipboard and deselects
the block. If no block is selected, copies the whole file.

Select All Selects the whole file.

Clear Selected Clears the selected block or file without copying or
printing.
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Windows

Minimize Makes the window as small as it can be.
Normal Sizes the window to the contents size.
Maximize Makes the window the same size as the screen.
Settings

Save As Defaults Saves the size, position, and location of the window for
future use

Tool Types
MultiView supports the following Tool Types:

CLIPBOARD View the Clipboard instead of the file.

CLIPUNIT= Specify the Clipboard unit to use when using the

<number> CLIPBOARD keyword. The range is 0 to 255; the
default is 0.

SCREEN Indicate that you want the object to appear on its own

screen, using the environment specified by the object.
For example, if an ILBM was Low Res, then the screen

would match.
PUBSCREEN= Indicate that you want the window to open on the
<name> named public screen.
FONTNAME= Font to use when viewing text objects. Note that the
<name> font extension must be left off.
FONTSIZE= Font size in points to use when viewing text objects.
<number>
BOOKMARK Go to the object and position specified by the
bookmark.
BACKDROP Indicate that the window should be a backdrop window.
WINDOW Open the MultiView window without an object so that it

can be placed in the WBStartup directory.
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WBStartup Drawer

The WBStartup drawer is provided to hold icons for programs that
you want opened at the time the Workbench is started. For
example, you may want the Clock program running when you
reboot or power on your Amiga. Drag the icon for each desired
program into the WBStartup window. The WBStartup drawer is
empty by default.

Tool Types

Programs in the WBStartup drawer can include the following Tool
Types:

DONOTWAIT Normally the Workbench waits for one program
to finish before it opens the next. DONOTWAIT
overrides this delay. DONOTWAIT does not
take an argument.

WAIT= <seconds> Specifies how many seconds the Workbench
should wait before opening the next icon in the
WBStartup drawer.

STARTPRI= <priority>  Assigns a priority to an icon so that it opens
before or after other icons. By default, all icons
have a priority of 0. The acceptable range is
from -128 to +127; the higher the value, the
higher the program's priority.

Expansion Drawer

The Expansion drawer is used to store software drivers for
additional hardware devices that you install on your Amiga. If a
hardware device uses the Expansion drawer, it is explained in the
documentation packaged with that product. To activate the new
device, drag the icon for the device's software driver into the
Expansion drawer and then reboot your system to make the device
available.
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Devs Drawer/Storage Drawer

The Devs and Storage drawers both contain the following drawers:
¢« Data Types

« DOSDrivers

o Keymaps

e Monitors

« Printers

Note Floppy disk only systems use a Storage disk instead of
a Storage drawer.

The Devs drawer contains the device driver files for the devices that
are currently active on the system. The Storage drawer or disk
contains device driver files that are not currently in use, except the
Data Types. You can drag Data Types to store in the Data Types
drawer in Storage if you wish. Storing unused files in the Storage
drawer or disk can save disk space on your boot disk.

Moving From Storage

Moving from Storage moves device drivers out of the Storage
drawer or disk and into the Devs drawer.

To activate a monitor or DOSdriver:

1. Double-click on the icon. The file is then active during the
current session only.

2. To activate the icon across sessions, drag it from the Storage
drawer into the corresponding Devs drawer and reboot your
system.

To activate a keymap:
1. Drag keymap files into the Devs drawer.

2. Select the appropriate Keyboard Type in the Input Preferences
editor.

To activate a printer driver:
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1. Drag printer files into the Devs drawer.

2. Select the appropriate Printer Type in the Printer Preferences
editor.

Data Types

Data Types are software files used by tools, utilities, editors, and
applications. They are used to describe file formats to the system,
such as picture files, sound files, and text files. The following
default Data Types are available on the Workbench:

8SVX IFF sound files
AmigaGuide Amiga Help files
FTXT IFF text files

ILBM Bitmap picture files

Adding Data Types from other applications into the Devs/Data
Types drawer makes them available for use by the Workbench, as
well as the application. Add new Data Types by dragging them into
the Devs/Data Types drawer.

DOSDrivers

DOSDrivers are software devices that extend the capabilities of
AmigaDOS.

Keymaps

Keymaps control the keyboard configuration. The default keymap
should be changed to use the keymap for any other keyboard
configuration. A list of corresponding keyboards and keymaps
appears in Chapter 5.

Monitors

The Devs/Monitors drawer and the Storage/Monitors drawer
contain icons for the available monitor types that you can use on
your system.
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Printers

The Devs/Printers drawer holds your printer drivers. On a floppy
disk system Devs/Printers is initially empty. Activating a printer
driver differs for floppy and hard disk systems.

For floppy disk systems, the Printers subdirectory of the Workbench
disk is initially empty. To use a printer with your Amiga:

1. Open the Devs drawer on your Workbench disk.
2. Insert your Extras disk and open the Storage/Printers drawer.

3. Drag your printer's icon onto the Devs/Printers drawer icon.
(For single floppy systems, follow the messages to change disks.)

4. Select the appropriate printer type from the Printer Preferences
editor.

If you have a hard disk system, the printer drivers you selected
during installation are in your Devs/Printers drawer and the rest
are in the Storage/Printers drawer.

To make a printer driver available:
1. Open the Storage/Printers drawer.
2. Drag the icon into the Devs/Printers drawer.

3. Select the appropriate printer type from the Printer Preferences
editor.



Chapter 5
Preferences

This chapter explains the Preferences editors found in the Prefs
drawer. These editors allow you to customize your Amiga
environment by:

Setting your preferred language

Setting the time and date

Choosing a keyboard driver

Changing the Workbench colors

Changing the shape of the pointer

Changing the size of the display area

Specifying a printer and setting it up for graphic output
Setting up a modem for use with the Amiga

Prefs Drawer

The Prefs drawer contains the icons for the Preferences editors and
the Preset drawer. Figure 5-1 illustrates the Preferences editors
window.
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Figure 5-1. Preferences Window

The following editors are listed in the order in which they are
described in this chapter:

Locale For selecting the language and locality

Time For setting the time and date

Input For changing the mouse speeds, key repeat speeds,
and selecting keyboard type

ScreenMode For choosing a different monitor display mode

Overscan For adjusting the size of the display area for text and
for graphics

Palette For changing the Workbench colors

WBPattern For selecting or creating background patterns for the
Workbench windows and screen

Pointer For changing the size, shape, and color of the mouse
pointer and busy pointer

Font For changing the fonts used in the different areas of
the screen

Printer For specifying the printer driver that matches your

printer and for specifying options, such as paper size
and margin width

PrinterGfx For setting up your printer to print graphics
PrinterPS For controlling output to a PostScript printer
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Serial For setting the specifications for the serial port, which
is used to communicate through modems or
networking systems

IControl For choosing miscellaneous system options, such as
the key used for screen drag

Sound For determining the sound your Amiga produces for
its "display beep"

Presets For storing different Preferences editor
configurations changed through the Project, Edit, and
Settings menus

Editor Menus and Presets Drawer

With the exception of Time, each editor has three menus: Project,
Edit, and Settings. These menus let you save and load Prefs preset
files, which allow you to quickly change to different configurations.
By default, these files are saved in the Presets drawer, although
they can be saved elsewhere. If you save icons for the files (by
selecting Create Icons?), you can activate the settings by opening
the file's icon, rather than opening the actual editor.

Project Menu

The Project menu options let you save the editor settings to a
specific file and open previously saved files.

Open Loads the information from a specified preset file.

Save As Specify the preset file in which to save the currently
displayed settings. The requester provides a default
file name in the Presets drawer. If you want to
change it, type in the complete path to a different file
and select OK.

Quit Exits the editor without performing any changes.
The same as Cancel gadget.
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Edit Menu

The Edit menu options allow you to restore previously used settings
or the default settings. The options are:

Reset to Default Returns the editor settings to the default settings.

Last Saved Returns the editor settings to the last settings you
saved.

Restore Returns the editor to the settings displayed when

the editor first opened.

The WBPattern and Pointer Edit Menus have the following
additional options:

Cut Copies and clears the whole work area to the Clipboard.

Copy Copies the whole work area to the Clipboard.

Paste Replaces the whole work area with the last thing cut or
copied.

Erase Deletes everything in the work area.

Undo Undoes the last action performed.

Load Image Opens a file requester for entering the name of an image
file to use as a background pattern or picture.

Reset to Resets the WBPattern to default settings.
Defaults

Last Saved Returns the last saved image to the magnified view box.

Restore Restores the magnified view box to its original state when
the editor was opened.

Settings Menu

The Settings menu contains the Create Icons? item that allows you
to save project icons representing your editor settings in the same
drawer as your files. For example, if you save printer specifications
to the SYS:Prefs/Presets/Printer.pre file, the icon for the file
appears in the Presets window. Double-click on the icon to activate
the file's settings.
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Using the Presets Drawer

Open the Presets drawer and double-click on a file's project icon to
use its settings. Or open the editor, choose the Open menu item,
and enter the file's complete path. Select Use to use the settings
until you reboot or open another editor file.

Locale Editor

The Locale editor lets you choose the languages with which you
interact with the Amiga. The default setting is USA English;
however, you can use the Locale editor to choose another language.
See Chapter 6 for a full description of the Locale editor.

Time Editor

The Time editor lets you set the date and time on your system.
Figure 5-2 illustrates the Time Preferences editor window.

2] B  feeil |

Sun Mon Tue Med Thu Fri Sat
i e

s e [ [0 P jwin
12 13 |14 [15 [16 [17 [18
TR R
% |2 [ |29 [

Hours _a
Minutes | B
T wamenm
Save | Use | Cancel |

Figure 5-2. Time Preferences Editor Window

To set the date:

1. Click the cycle gadget in the upper right corner until the correct
month is displayed.
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2. Select the year text gadget, delete the incorrect year, and enter
the correct year.

3. Select the correct day from the calendar display. The day is
highlighted when selected.

To set the time:
1. Point to the slider bar in either the minute or hour slider.

2. Drag the bar to the right to increase the value and to the left to
decrease the value. When the correct value is shown, release
the selection button. Repeat these steps for the other slider.

Input Editor

The Input editor allows you to change the speed at which the mouse
and keyboard operate and to select your keyboard type. Figure 5-3
illustrates the Input Preferences editor window.

House Speed: 3 -l

ficceleration: British

Doubte-Click Delay: 75 ___________l (:::dun o
Show Double-Click > mﬁiﬁh

Test noubr’e-'(uqk > : gspaﬁol

rangais
* Haliana

~ Norsk

Key Repeai Délay 3 | g:rht‘g?gts

Key Repeat Rate: 180 Suisse A

Keyboard Test! : Svenskt Vi
_SM ; Use : . Cancel |

Figure 5-3. Input Preferences Editor Window

Mouse Speed

The Mouse Speed slider determines how fast the mouse pointer
moves across the screen relative to mouse movement. The faster
the pointer moves across the screen, the less surface space and
effort is needed to move the mouse.
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Choose from three mouse pointer speeds: 1, 2, and 3, where 1 is the
slowest and 3 is the fastest. Set the mouse pointer speed by
dragging the slider bar until the desired value is displayed. The
mouse speed takes effect while you set it, allowing you to try each
speed without exiting the editor. The default value is 3.

Acceleration

The Acceleration feature is used for moving the pointer quickly over
large screen areas while retaining fine control for smaller
movements. If acceleration is on, the pointer speed remains
constant within a small area. However, as the pointer is moved
further across the screen, its speed increases, moving it quickly over
a large area of the screen.

Select the check box to turn acceleration on or off. The default
value is off.

Double-Click Delay

The Double-Click Delay slider determines how fast the mouse
registers a double-click of the selection button.

The range is from 1 to 200, with 1 being the least delay. The Show
Double-Click gadget shows the amount of time for the selected
value. The default value is 75.

Test your chosen speed by double-clicking in the Test Double-Click
gadget. When the double-click takes place within the allotted time,
a "Double-Clicked" message appears next to the gadget; if not, a
"Too Slow" message appears.

Key Repeat Delay

Most of the keys on the keyboard automatically repeat when held
down. Change the delay that occurs before the key repeats with the
Key Repeat Delay slider.

The current setting is shown on the slider value. The range is from
1 to 75, with 1 being the least delay. To increase the delay, drag the
slider bar to the right and to the left to decrease it. The default
value is 30.
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Key Repeat Rate

The Key Repeat Rate slider determines the rate at which the keys
repeat after the initial key repeat delay.

The range is from 1 to 125, where 1 is the slowest. To increase the
speed, drag the slider bar to the right and to the left to decrease it.
The default value is 100.

Keyboard Test

The Keyboard Test gadget allows you to test the settings chosen for
the key repeat delay, the key repeat rate, and the keyboard type.

Select the gadget and hold down one of the alphabetic keys on the
keyboard. The Keyboard Test gadget shows the current key delay
and key repeat rate.

Keyboard Type

The Keyboard Type list lets you select the appropriate keyboard
type for your language.

The available keymaps and the corresponding keyboards are:

Keymap Keyboard
cdn French Canadian
chi Swiss French
ch2 Swiss German
d German

dk Danish

e Spanish

f French

gb Great Britain

i Italian

n : Norwegian

po Portuguese
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Keymap (cont'd) Keyboard (cont'd)

s Swedish
usa2 Dvorak

Choosing a particular keyboard type activates the corresponding
keymap file in the Devs/Keymap drawer. Select your keyboard type
in the Input Preferences editor and your keymap in the
Devs/Keymap. If your corresponding keymap is not in the
Devs/Keymap drawer, open the Storage/Keymap drawer and drag
the correct icon into the Devs/Keymap drawer.

ScreenMode Editor

The ScreenMode editor, illustrated in Figure 5-4, lets you select the
display mode for the Workbench screen. Since the modes have
different properties and hardware requirements, review the
descriptions provided here and in Appendix B to determine which
modes are available on your system and best meet your needs.

Display H_nde o _ Mode Properties
[visible Size : 648x 28
Mininun Size : 648 x 208

Haximum Size : 16368 x 16384
Haxinun (olors 16 -

EURO:36Hz High Res Laced
EURO:36Hz Super-High Res
wno 36Hz Super-High Res Laced
172Hz Productivity
| EURD:72Hz Productivity Laced

HULTISCAN:Product ivity Requires ECS

 |Does not support genlock

MULTISCAN:Product ivity Laced Dragaable
Hidth: V| Default 'j T3z, 15.6%Khz
Ilelsht: _‘ pefau]t
(otnrs: 4 il

AutoScroll: __]

Save ] o e , £ Cancel l

Figure 5-4. ScreenMode Preferences Editor Window

The available display modes are listed on the left; the properties of
the mode selected is displayed on the right.
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Types of Displays
A display mode is defined by:

«  Resolution (horizontal and vertical dimensions in pixels)
o Vertical and horizontal scan rates (measured by Hz and kHz)

« Color palette (the largest number of colors that can be displayed
on the screen at one time and the size of the palette from which
the displayable colors can be chosen)

Most display modes have an interlace option. Interlacing doubles
the vertical resolution to allow you to get twice as much information
on the screen. It also makes the output of many display modes
video-compatible. Interlaced screens may, however, flicker when
used with certain monitors. Consult your monitor documentation to
make sure that it supports interlacing before selecting this feature.

Some display modes have a Super-High Res option, which doubles
the number of pixels displayable horizontally. While this increases
the screen resolution, it reduces the number of colors available.

Using the ScreenMode Editor

The available display modes are shown in the Display Mode list.
Scroll through the list to see all modes available. The available
modes reflect the presence of the associated monitor files in
Devs/Monitors.

Select a display mode from the list by clicking on it. The selected
mode appears in the display box under the Display Mode list. Select
Save to use the mode and save it as the default in future sessions.
Select Use to use the mode for the current session only. Select
Cancel to exit the editor without making any changes.

If you select Save or Use while an application or Shell window is
open on the Workbench screen, a requester appears, asking you to
close any open windows other than drawers. When you have closed
the last open Shell or application window, the Workbench screen
automatically resets to the new display mode.

Your chosen display mode pertains only to the Workbench screen.
Applications opening their own screens supply documentation of the
display modes they support.
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Mode Properties

The Mode Properties display box lists information about the display
mode selected. It displays screen sizes and maximum displayable
colors for the selected display mode and other mode properties.

Screen sizes corresponding to the currently selected display mode
are given in number of pixels. The first number represents the
width of the screen; the second number represents the height.

Visible Size The size of the text overscan area as determined
by the Overscan settings.

Minimum Size The smallest, or minimum, screen size supported
by the selected display mode.

Maximum Size The largest, or maximum, screen size supported
by the selected display mode. The amount of Chip
memory available may further restrict this size.

Maximum Colors The maximum number of colors displayable on a
screen in the selected display mode.

The possible mode properties that can be displayed include:

Interlaced The display mode is interlaced.
ECS Only available if your Amiga has the Enhanced
Chip Set.

Supports Genlock The display mode supports the use of video
genlock equipment.

Draggable The display mode supports a draggable
Workbench screen. A draggable screen can be
pulled down to reveal any other open screens
behind it.

Width/Height

Use the Width and Height text gadgets to customize the size of your
Workbench screen. Enter a number between, or equal to, the
minimum and maximum width and height. Once the number is
entered, that number remains constant no matter what display
mode is selected until the corresponding Default gadget is selected.
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Entering numbers larger than the maximum or smaller than the
minimum do not increase or decrease the display mode size beyond
the default setting.

The Default check box to the right of each gadget lets you select the
default setting for the width and/or height. This equals the visible
size.

All modes, except the A2024 modes, allow you to specify a Width
and Height much larger than the visible size. This extra-large
"virtual" Workbench screen lets you open larger and more non-
overlapping windows than otherwise possible, limited only by
available Chip memory.

Colors

The Colors slider gadget lets you select the number of colors that
can be displayed on the screen. The fewer colors selected, the faster
the screen can be redrawn and the less memory used.

AutoScroll

Selecting AutoScroll automatically scrolls the screen when the
mouse reaches the edge of the screen's visible portion. This is
useful when you have defined a Width and Height for the screen
that is larger than the visible size.

Overscan Editor

The Overscan editor, illustrated in Figure 5-5, enlarges the size of
your screen to use the normally extra space unused around the
edges of the monitor screen, known as the overscan area.
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Figure 5-5. Overscan Preferences Editor Window

The MonitorTypes available reflect the presence of the associated
monitor files in Devs/Monitors.

When you change the overscan values for a particular display
group, all modes within that group are affected. To change the
overscan values for a display group, point to the group in the
scrolling list, and click the selection button. The selected group is
highlighted in the scroll gadget.

Edit Text Size

The Edit Text Size gadget, illustrated in Figure 5-6, lets you adjust
the area available for text display.
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Figure 5-6. Edit Text Size Window

The black rectangles on the screen are handles and the line
connecting the handles represents the outermost area where text
can be displayed. Enlarge the overscan area by pointing to a
handle, holding down the selection button, and dragging the handle
to the edge of the screen. Only the active handle is visible on the
screen when you drag it.

Moving any part of the handle off the screen or out of the viewing
area overenlarges it, losing a portion of the visible text.

Use the center handle to position the screen. By dragging the
handle, you can shift the screen slightly to the right or left or up or
down to center the display area on your monitor screen.

To accept changes and return to the Overscan editor, select Use. To
exit the screen without accepting any changes and return to the
Overscan editor, select Cancel.

Edit Graphics Size

The Edit Graphics Size gadget lets you adjust the standard display
size with a screen similar to the Edit Text Size screen.
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The handles and the lines connecting them represent the outermost
area where images can be displayed. Use the mouse to drag the
handles so that the line connecting them completely encompasses
the screen. The resulting area should be slightly larger than the
monitor screen. As with the Edit Text Size screen, use the center
handle to position the screen. Only the active handle is displayed
when you drag it.

To accept changes and return to the Overscan editor, select Use. To
exit the screen without accepting any changes and return to the
Overscan editor, select Cancel.

Dimensions

The different sizes of the overscan areas are displayed on the right
of the Overscan window. The sizes are given in number of pixels,
representing the width and the height of the screen.

For PAL or NTSC groups, the sizes correspond to the sizes for a
standard High Res screen. If Multiscan is selected, the sizes for a
non-interlaced Productivity screen are given. All other display
modes in a group are affected proportionally.

The size categories are:

Minimum The standard, non-overscan size of a screen
Text The current Text Overscan size

Graphics The Graphics Overscan size

Maximum Maximum allowable size for any overscan area,

text or graphics
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Palette Editor

The Palette editor, illustrated in Figure 5-7, lets you change the
colors of the Workbench.
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Figure 5-7. Palette Preferences Editor Window

The left side of the Palette Preferences editor window displays the
four and eight current Workbench colors in the selection gadget, a
color wheel with intensity indicator, and color sliders that can be
RGB (red, green, blue) or HSB (hue, saturation, brightness)

depending on your Slider Color Model menu selection. (RGB is the
default setting.) '

The right side of the Palette Preferences editor window has a Color
Mode cycle gadget with two settings: Multicolor Settings and 4
Color Settings. The Multicolor Settings gadget is for setting eight
Workbench colors. The 4 Color Settings gadget is for setting four
Workbench colors. Both modes should be set to accommodate
editors and applications that use one setting or the other.
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The Palette Preferences editor window displays the following nine
items for which you can select specific colors:

+ Background

o« Text

« Important Text

e Bright Edges

e Dark Edges

o Active Window Titlebars

o Active Window Titles

o Menu Background

o Menu Text

Depending on the display mode set in the ScreenMode Preferences
editor, the bottom of the Palette Preferences editor window displays
a sample window that changes as you change color selections. If
this does not appear on your Palette Preferences editor window, a

Show Sample gadget is displayed instead. Clicking on this gadget
displays the sample window showing your color selections.

To change a color in RGB mode:

1. Point to a color in the selection gadget and click the selection
button.

2. Use the slider gadgets to change the selected color. The color in
the display box and on the sample screen changes as the bar is
dragged through the slider box.

Changing the black and white settings may affect the three-
dimensional appearance of the screen. Be sure colors replacing
black are darker than colors replacing white.

To change a color in HSB mode:

1. Point to a color in the selection gadget and click the selection
button.

2. Use the slider gadgets to change the selected color. The color in
the display box and on the sample screen changes as the bar is
dragged through the slider box.
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The Hue slider changes the basic color, the Saturation slider
changes the amount of color, and the brightness slider changes
the lightness or darkness of the color.

To change color using the color wheel:

1. Point to a color in the selection gadget and click the selection
button.

2. Point to the color intensity indicator within the color wheel and
hold down the selection button.

3. Moving the mouse pointer moves the indicator on the color
wheel, changing the color in the display box and on the sample
screen as the indicator moves. Release the selection button
when you reach the color you want.

In addition to the standard Preferences menus, the Palette editor
also has a Presets menu item in the Edit menu that contains
predetermined color settings and a Settings menu item that lets you
determine which Slider Color Model to use for changing your colors.

If you have a monochrome monitor or if you choose a color setting of
2 in the ScreenMode Preferences editor, the Palette Preferences
editor only displays RGB color sliders.

WBPattern Editor

The WBPattern editor lets you change the background display of
the screen and the Workbench and its windows. The WBPattern
editor window is illustrated in Figure 5-8.
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Figure 5-8. WBPattern Preferences Editor Window

The Placement cycle gadget lets you select Workbench, Windows, or
Screen for displaying a background.

The Type cycle gadget lets you select either Pattern or Picture.

Applying Background Patterns

You can select an already existing pattern or create your own to fill
any open areas of the window. The default is no pattern.

To choose a preset pattern:

1.

Make a selection in the Placement cycle gadget: Workbench,
Windows, or Screen.

Select Pattern from the Type: cycle gadget.

Select one of the patterns in the Presets gadget to show a
sample in the display box above it.

You may optionally select the Test gadget to apply the pattern
to the screen without exiting the editor.
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To create a pattern:

1. Make a selection in the Placement cycle gadget: Workbench,
Windows, or Screen.

2. Select Pattern from the Type: cycle gadget.

3. If there is a pattern in the magnified view box, select the Clear
gadget to fill the magnified view box with the currently selected
color as a background.

4. Select a color for drawing from the color selection gadget. Or
select a pattern from the Presets gadget and use the mouse to
- edit it.
5. Point within the magnified view box to where you wish to draw
and click the selection button.

One pixel of the selected color appears where you position the
mouse pointer. Holding down the selection button and moving
the mouse fills in several pixels at once. Switch to another color
by moving the pointer over the color selection gadget and
selecting the next color.

As the pattern is created in the magnified view, it also appears
in the actual-size box. If you make a mistake while drawing,
use the Undo gadget to erase the last action performed by the
mouse.

6. When the pattern completes, select the Test gadget to see how it
appears on the screen.

Applying Pictures

You can apply a picture or graphic file to the background of the
Workbench, Windows, or Screen. Pictures can be created in a paint
package or you can load digitized picture files into the editor.
Pictures are mapped to the colors of the screen.
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To select an existing picture file:
1. Select Picture from the Type: cycle gadget.
2. Click on the Select Picture gadget.

3. In the file requester, enter the filename of the picture you wish
to use.

4. Optionally select the Test gadget to apply the pattern to the
screen without exiting the editor.

WBPattern Edit Menu

The WBPattern Edit menu has additional items that let you use
other drawing programs to create and edit patterns and to use
existing images from other sources. For example, you can use the
drawing capabilities of the IconEdit tool, described in Chapter 10, to
create a design and then load it into WBPattern.

Cut Copies the contents of the magnified view to the Clipboard
and clears the view to the background color.

Copy Copies to the Clipboard without clearing the view.

Paste Copies an IFF image from the Clipboard to the magnified

view, replacing whatever is currently there. (Images larger
than the 16 x 16 pixel view are cut off on the bottom and

right sides.)
Erase Clears the magnified view to the background color.
Undo Operates the same as the Undo gadget, exchanging the

contents of the Undo and magnified views.

Load Image Opens a file requester for entering the name of an image file
to use as a background pattern.

Reset to Resets the WBPattern to default settings.
Defaults
Last Saved Returns the last saved image to the magnified view box.

Restore Restores the magnified view box to its original state when
the editor was opened.

When you Save or Use, all selected patterns or pictures are saved
and/or applied where designated. Selecting Cancel also cancels any
patterns or pictures applied with Test gadget.



Chapter 9
Printers

This chapter describes how to set up your Amiga to communicate
with a printer. It provides instructions on how to use:

« Printer drivers

o Printer Preferences editor

o PrinterGfx Preferences editor
o PrinterPS Preferences editor

To set up a printer, you must have the necessary printer driver in
Devs/Printers and select the printer in the Printer Preferences
editor. The PrinterGfx Preferences editor allows you to select
optional printer graphics features. The PrinterPS Preferences
editor allows you to set up and print using a PostScript printer.

Printer Drivers

A printer driver acts as a translator that enables the Amiga to
communicate with a particular model of printer. Different printers
require information in different formats. The printer driver takes
the information from the Amiga and translates it into the proper
format for the particular printer. The printer driver you select is
used for both the text and graphic output.

A printer driver must be in the Devs/Printers drawer of the Amiga's
boot volume for it to be available for use. Printer drivers are
shipped in the Storage/Printers drawer on the Amiga Extras disk.
If the printer driver you need is not in Devs/Printers, copy it from
Storage/Printers.

The following are instructions for copying printer drivers on floppy-
only systems:
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Select the Workbench window and open the Devs drawer.
Insert the Extras disk into your disk drive and open its window.

Open the Storage drawer.

W N

Open the Printers drawer in the Storage window. Scroll
through the printer driver icons until you find the driver for
your printer.

5. Drag the appropriate printer driver icon over the Printer
drawer icon in the Workbench Devs window.

On a single drive system, requesters ask you to swap the
Workbench and Extras disks to complete the copy.

On a dual floppy drive system, insert a disk in each drive and
then copy from the Extras disk directly to the Workbench disk.

Printer Output Devices

The standard Amiga printer output device is PRT:, which is used by
all Amiga printer drivers. You can bypass the Amiga printer driver
by redirecting output to PAR: or SER:, which sends the output
directly to the parallel or serial port. Redirecting to PAR: or SER:
allows an application's printer driver to be used instead of the
Amiga's printer driver.

Multiple Devices

On systems with more than one printer or with more than one
parallel or serial port, use the UNIT Tool Type to select the output
device you want to use.

Enabling the UNIT Tool Type for the Serial Preferences editor
displays the Default Unit text gadget in that editor's window for
designating your serial output device. Enter the serial port number
to which the destination printer is attached and select Use. When
the Printer Port is set to Serial in the Printer Preferences editor,
print output is sent to that printer. (All parameters in the Serial
editor must be set correctly for your serial printer to work.)
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Enabling the UNIT Tool Type for the Printer Preferences editor
displays the Device Unit text gadget in the editor's window. If you
have serial or parallel hardware with multiple ports, each port has
its own unit number. Refer to the hardware manufacturer's
documentation for the proper unit number to use.

Printer Preferences Editor

The Printer Preferences editor lets you select a printer driver, the
printer port, and various text options. Figure 9-1 illustrates the
Printer Preferences editor window.
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Figure 9-1. Printer Preferences Editor Window

The Printer Type scroll gadget displays a list of available printer
drivers currently installed in the Devs/Printers drawer.

Select a printer driver by pointing to its name and clicking the
selection button. The selected driver is shown in the display box
underneath the scroll gadget.
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Note If you are setting up a PostScript printer using the
Printer Preferences editor, the text and graphics
settings made in the Printer Preferences and
PrinterGfx Preferences editors are overridden.
However, you must still select a Printer Port here.

If a driver for your printer is not in the Devs/Printers drawer or the
Storage/Printers drawer, select Generic. For many printers, this
allows you to print plain text without graphics or other type styles,
such as italics or boldface.

The Printer Preferences editor window contains the following
gadgets:

Printer Port

Specifies the Amiga port where the printer is attached: Serial or
Parallel.

Print Pitch

Specifies the pitch, which is the number of characters printed per
inch (cpi) horizontally. The higher the number, the narrower the
characters. Choose between Pica, Elite, and Fine.

Print Spacing

Specifies the number of lines of text that are printed in one vertical
inch of space. Select 6 lines per inch (Ipi) or 8 Ipi; the higher the
number, the less space between the lines.

Print Quality

Determines the quality of the printout. Selecting Draft produces
lower quality printouts with faster printing. Selecting Letter
produces higher quality printouts with slower printing.
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Paper Type

Specifies the type of paper used. The options are Continuous
(tractor feed paper) or Single (individual sheets).

Paper Format

Specifies the size of paper used. Selecting Custom as the paper size
eliminates printing problems that occur with dot matrix printers. If
Custom is selected, be sure to specify in the Paper Length gadget
the correct number of lines that fit on the paper.

Paper Length

The total number of lines on the page, including top and bottom.
For example, 11-inch paper with six lines to an inch is 66 lines to
the page. To change the default value, select the gadget, delete the
existing value, type in the new number, and press Return.

Left Margin

The width, in numbers of characters, from the left edge of the paper
to the starting text position. The pitch of the type (number of
characters in a horizontal inch) affects the size of the margin. For
example, a one inch margin is equal to 10 when 10 pitch type is
used. To change the default value, select the gadget, delete the
existing value, type in the new number, and press Return.

Right Margin

The width, in numbers of characters, from the left edge of the paper
to the position where the right margin is to begin. To change the
default value, select the gadget, delete the existing value, type in
the new number, and press Return.
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PrinterGfx Preferences Editor

The PrinterGfx Preferences editor supports extended printer
graphics features. Before using the PrinterGfx editor, be sure to
select the printer driver for your printer with the Printer
Preferences editor. Figure 9-2 illustrates the PrinterGfx
Preferences editor window.

Note If you are setting up a PostScript printer using the
Printers Preferences editor, the text and graphics
settings made in the Printer Preferences and
PrinterGfx Preferences editors are overridden.
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Figure 9-2. PrinterGfx Preferences Editor Window

The PrinterGfx Preferences editor contains the following gadgets:

Dithering

Dithering prints patterns of dots in different colors (or different
densities) so that they appear as one color or as shades of grey. The
available dithering options are:
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Ordered

Halftone

Floyd-Steinberg

The standard type of dithering. Color intensities are
formed using an ordered pattern of dots. The dots vary
in color, but are of the same density and are printed in
straight rows and columns.

Color intensities are formed by varying the size and
density of the dots.

Color intensities are formed by a complex algorithmic
formula. Floyd-Steinberg dithering yields smoother
shading by distributing the intensities of each pixel
throughout the dots comprising that pixel, as well as
throughout neighboring dots.

Figure 9-3 illustrates the results of the different dithering methods;
the pictures were generated on a 300 dot per inch printer.
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Figure 9-3. Dithering Methods
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Scaling

Scaling is the process of changing the size of an image. The actual
size of the printout is determined by the Limits setting, described on
page 9-11. The available Scaling options are:

Fraction Closely matches the size you have set in Limits, possibly
distorting the image. Pixels are enlarged or reduced as
necessary. This option works best when printing pictures
with extensive shading.

Integer Prints every pixel on the screen as an even number of
dots on the printout. (If a picture on the screen is 320 x
200, the printed picture is either 320 x 200, 640 x 400, or
960 x 600.) Select this option when printing a picture that
contains thin vertical and horizontal lines (such as a grid)
or text.

Image

Determines how an image is printed. This option affects only Black
& White and grey scale printing. When set to Positive, the image is
printed as it appears on the screen. When set to Negative, the
image is reversed, similar to a photographic negative.

Aspect

Determines the direction on the paper the image is printed. When
set to Horizontal (often called Portrait), the image is printed as it
appears on the screen. When set to Vertical (often called
Landscape), the image is printed sideways.

Shade

Allows you to select the colors to print. Not all printers support
these options. The available options are:

Black & Colors are printed as either black or white, determined by

White the Threshold setting. Dithering has no effect.

Grey Scale 1 Colors are printed in varying shades of grey.
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Grey Scale2  This option supports a maximum of four shades of grey and
is used for printing pictures designed using the A2024
monitor.

Color Colors are printed as they appear on the screen. This can
only be used with color printers. ’

Threshold

Determines the colors on the screen that are printed as black or as
white. This setting is effective only in Black & White mode.

Increasing the Threshold value causes more colors to be printed as
black. Figure 9-4 shows the results of different Threshold settings.

Threshold = 8 Threshold = 13
Figure 9-4. Threshold Settings

Density

Selects the graphics print density. The lower the density, the faster
the image prints on those printers with multiple densities. When a
higher density is selected, more dots create a sharper image.
However, it takes longer for the image to print.

This option is not supported by every printer.
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Smoothing

Used to smooth any diagonal lines that appear jagged. This option
is best suited for use with programs that do graphic dumps of text.
When smoothing is turned on, printing may be slower.

Floyd-Steinberg dithering cannot be used with Smoothing.

Center Picture

Horizontally centers the printed picture on the page. Any value
entered for the Left Offset is ignored when Center Picture is on.

Color Correction

Matches the colors on your printout more closely to the colors on the
screen. Color correction can be used on red, green, or blue or on a
combination of colors.

Color correction reduces the number of printed colors. When color
correct is not used, all the available colors displayed by the Amiga
can be printed on a color printer. For each color that is chosen for
correction, several shades of that color are lost. The number of
colors that can be printed is shown in the Colors gadget to the right
of the color correction boxes.

Left Edge

Determines the distance to shift, or offset, the printed picture. This
is similar to setting up a left margin. The Center Picture option
disables Left Edge.

To enter the value, select the Left Edge gadget, delete the current
value, enter the correct value, and press Return. Choosing Use
Metric System? in the Settings menu lets you specify the value in
millimeters rather than tenths of inches.
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Limits/Type

Interprets the Width and Height limits, depending on the Type
setting. The available options are:

Ignore Ignores Width and Height limits. The printed picture's size
is the size requested by the application. The only
restrictions are that its width cannot be greater than:

(right margin - left margin) + 1
characters per inch/mm

Height is usually restricted to the length of the paper.

Bounded The printed picture's size is bounded by the Width and
Height limits. For example, if the printed picture can be up
to 4.0 x 5.0 inches, set Width to 40, Height to 50, and select
Bounded. Width and Height are interpreted in tenths of
inches by default or millimeters if Use Metric System? has
been chosen in the Settings menu.

Absolute The Width and Height limits are interpreted as absolute
values. For example, if the printed picture should be
exactly 4.0 x 5.0 inches, set Width to 40, Height to 50, and
select Absolute. This distorts the picture as needed to fit.
To use this option fraction scaling should also be selected.
Choosing Use Metric System? in the Settings menu lets you
specify the value in millimeters rather than tenths of inches.

You can, however, use Absolute to get a normal aspect
ratio printout that is a specific width or a specific height, but
not both. Set either the Width or Height limit to the desired
dimension and set the other limit to zero. For example, if
Width is set to 40 and Height to 0, then the printed picture is
4.0 inches wide and as tall as necessary for the correct
aspect ratio. If both dimensions are set to zero, the printed
picture is as wide as possible and as tall as necessary to
retain the picture's proportion.

Pixels The Width and Height limits are interpreted as pixels. If one
of these values is set to zero, the same rules for the
Absolute option apply. The printout is the width or height
specified and as tall or as wide as necessary to retain
proportion.
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Multiply The Width and Height limits are used to multiply the source
picture's width and height. For example, if you specified a
Width of 2 and a Height of 4, the printed picture is two times
the source picture's width in pixels and four times the
source picture's height.

Width/Height Lets you specify the dimensions of your printout. The value
is interpreted as increments of tenths of an inch or
millimeters, unless Pixels or Multiply is the selected Type.
To enter a value, select the text gadget, delete the current
value, type the correct value, and press Return.

Hints for Faster Graphics Printing

o Lower the density.
o Use the horizontal rather than the vertical aspect setting.

o Set Shade to black and white if you are using a two color image.
This is faster than grey scale or color printing.

« Use Smoothing for final copies only since it doubles the printing
time.

o Use Ordered or Halftone dithering because they do not increase
printing time. Floyd-Steinberg dithering doubles printing time.

e Speed up a High Res screen print that uses more than four
colors by moving the screen to the back of the display after
printing has started. Press left Amiga+N to do this.

PrinterPS Preferences Editor

The PrinterPS Preferences editor, illustrated in Figure 9-5, allows
you to control text and graphics printing on PostScript printers.
Use this editor only if you have a PostScript printer and if you
choose PostScript in the Printer Preferences editor.
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Figure 9-5. PrinterPS Preferences Editor Window

The PrinterPS Preferences editor has an additional item in the
Settings menu: Measuring System. Its submenu lets you select
Centimeters, Inches, or Points. The selected units are used to
display values of your width, height, and margin settings. The
default setting is Inches.

The PrinterPS Preferences editor contains the following gadgets:

Driver Mode

Driver Mode lets you select either PostScript or Pass Through. In
PostScript mode the driver converts any text output it receives to
PostScript and sends the results to the printer. The Pass Through
option bypasses the PostScript driver and sends data directly to the
printer. The Pass Through option lets programs that output
PostScript send their PostScript code directly to the printer.

Copies

This specifies the number of copies of each page to print, from 1 to
99.
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Other Workbench
Programs

This chapter describes the programs found in the Tools and
Commodities drawers.

Tools Drawer

The Tools drawer window, illustrated in Figure 10-1, contains
programs that expand your printing options, allow you to change
the color of non-Workbench screens, define new keys, and create
new icons.

Calculator InitPrint

ﬁaphtcl)tmp K—'S—Thﬁ‘ P;fp(ap;\

Figure 10-1. Tools Window -
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The following programs are found in the Tools drawer:

IconEdit Allows you to change and create icons.

CMD Allows you to redirect printer output to a file.

MEmacs A text editor, explained in the Using AmigaDOS manual.

Calculator A standard, four-function calculator.

KeyShow Displays the current keymap.

GraphicDump  Allows you to print screen images.

InitPrinter Initializes your printer.

PrintFiles Sends files to the printer.

ShowConfig Shows configuration information.

Lacer Turns video interlace on and off.

PrepCard Prepares PCMCIA memory cards for use on systems with
a PCMCIA slot.

Commodities A drawer containing programs that monitor your keyboard
and mouse input.

HDBackup and HDToolbox are also included in the Tools drawer on
hard disk systems. For more information on these programs, see
your Amiga hard drive user's manual.

IconEdit @_l

IconEdit personalizes your Workbench by changing the appearance
of existing icons and creating new ones.

The window shown in Figure 10-2 appears when you open the
IconEdit icon.
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Figure 10-2. IconEdit Window

Draw and edit icons in the magnified view box of the IconEdit
window. The Normal and Selected view boxes show the icon images
at actual size. Several gadgets in the window draw squares, circles,
and straight lines, giving you more control over your drawing.

There are three sub-windows in IconEdit: the Normal and Selected
view boxes and the Magnified View Box, which fills most of the
window. Each of these is an "AppWindow"-- you can drag an icon
into that window to load it, rather than using menus. Clicking in
the Normal view box displays the selected image of the icon as long
as you hold down the selection button.

Color Selection Gadget

The Color Selection gadget lets you select a color for drawing. In
addition to the standard method for selecting a color by pointing to
it and clicking the selection button, this gadget allows you to choose
two colors at once.

To create a "checkerboard" pattern, select the first color, hold down
Shift, then select the second color.

To create a pattern of vertical bars, select the first color, hold down
Alt, then select the second color.
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Keyboard shortcuts: Press P to cycle forward through the colors.
Press Shift+P to cycle through dithered patterns using the
background color. Press/ (slash) to reset the color to a solid pattern.

Magnified View Box

Use the mouse to draw your icon in this box. Click the selection
button to display a pixel of the selected color. Hold down the
selection button to draw while moving the mouse.

The pointer turns into cross hairs when it is in the magnified view
box. The new pixels appear at the center of the cross hairs. Pixel
coordinates (relative to the upper left corner) appear in the IconEdit
window title bar to show the position of the crosshair.

To load an existing icon into IconEdit, drag the icon into the
magnified view box.

Freehand Gadget g s

The Freehand gadget lets you quickly draw unstructured shapes. If
you select this gadget and then draw in the magnified view box, the
pixels fill in as the mouse passes over them. However, you may not
get a continuous line and some pixels may not be filled in. Use this
gadget to sketch an icon that you intend to fill in the details on’
later.

Keyboard shortcut: Press S to select the freehand gadget.

Continuous Freehand Gadget :_\-'_I

The Continuous Freehand gadget is similar to the freehand gadget,
except that it produces a continuous line. When drawing
continuous lines, there is a delay before the display catches up with
your movement. :

Keyboard shortcut: Press D to select the continuous freehand
gadget.
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Circle Gadget C'l

To draw a circle or oval:

1. Select the circle gadget.

2. Point inside the magnified box at the point where you want the
center of the circle, hold down the selection button, and move
the mouse.

3. Release the selection button when you reach the correct size and
shape.

Selecting the right portion of the gadget draws filled circles. To fill
the circle with a dithered pattern, select two colors from the
selection gadget.

Selecting the left portion of the gadget draws an outline of a circle.
To double the thickness of the circle's outline, hold down Ctrl before
releasing the selection button.

Keyboard shortcut: Press E (for ellipse) to draw an outlined circle;
Shift+E for a filled circle.

Box Gadget - [ |

To draw a box:
1. Select the box gadget.

2. Point inside the magnified box at the point where you want a
corner of the box, hold down the selection button, and move the
mouse.

3. Release the selection button when the box is the correct size and
shape.

Selecting the right portion of the gadget draws filled boxes. To fill
the box with a dithered pattern, select two colors from the color
selection gadget.

Selecting the left portion of the gadget draws an outline of a box. To .
double the width of the box's sides, hold down Ctrl before releasing
the selection button.
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To draw a three-dimensional box, similar in appearance to the
Workbench gadgets, hold down an Alt key while drawing a box
outline. To draw an "unselected" box hold down left Alt. To draw a
selected box, hold down right Alt.

Keyboard shortcut: Press R for an outlined box; Shift+R for a filled
box.

Line Gadget ll

To draw a straight line:

1. Select the line gadget.

2. Position the mouse where you want the line to start.
3. Hold down the selection button.

4. Move the mouse to the line ending position.

5. Release the selection button.

Double the thickness of the line by pressing Ctrl before releasing
the selection button.

Keyboard shortcut: Press L to select the line gadget.

Fill Gadget .ﬂ

Use the fill gadget to fill an area of the magnified view box with the
selected color. Select the fill gadget, then click within the area you
want to change to the same color as the dot under the crosshair.

Note The fill gadget does not fill a patterned area. However,
solid areas can be filled with the checkerboard or
vertical bar patterns, if selected.

Keyboard shortcut: Press F to select the fill gadget.
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Undo

Select Undo to cancel the last mouse action performed in the
magnified view box. Undo acts as a toggle switch; selecting it again
undoes the Undo.

Keyboard shortcut: Press U to select the Undo gadget.

Clear

Select the Clear gadget to erase the contents of the magnified view
box. The magnified view box fills with the currently selected color.

Keyboard shortcut: Press Shift+C to select the Clear gadget.

Normal/Selected Radio Buttons

The Normal and Selected radio buttons switch between unselected
and selected images for an icon. The normal image is how an
unselected icon looks. The selected image is how an icon looks after
you have clicked on it.

When the Normal radio button is selected, any image drawn in the
magnified view box appears in the normal view box at the top of the
window.

When the Selected radio button is used, you can create the image
that appears when the icon is selected. You can only use this radio
button when the Image menu item is chosen from the Highlight
menu. Any image created appears in the selected view box.

Keyboard shortcut: Press Shift+S to select the Selected radio button;
Shift+N for the Normal radio button.

Arrows

The arrows let you shift your image. Clicking on an arrow moves
the image in the magnified view in the direction of the arrow. Use
these arrows to control the placement of your image within the box
surrounding the finished icon.
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Note Any part of the image that is moved off the edge of the
magnified view box is lost.

Keyboard shortcut: Press the corresponding arrow key to move the
image.

Project Menu

The items in the Project menu let you open and save icon files.

New AN Loads the default icon for the currently chosen
type of icon. (The type of icon is determined by
the Type menu.) Any changes in the window that
have not been saved produce a requester asking if
you want to save them.

Open Ao Opens an existing icon file. A requester appears
for entering the name of the file. Only the names
of drawers and .info files appear in the IconEdit
Open file requester.

Save Als Saves an existing icon file, overwriting any file with
the same name. In this case the previous icon is
lost.

Save As AA Allows you to specify a filename for saving the

current image. A requester lets you enter the
destination for the edited icon. Use Save As to
prevent overwriting an existing icon file.

Save As Ab Saves the current image as the default icon for the

Default Icon currently selected icon type. This image is used
for any new icon or pseudo-icon of that type
created, including those made with the New menu
item in the IconEdit Project menu.

For example, if you create a drawer icon and then
choose Save As Default Icon, that icon is used to
represent drawers when you choose the Show All
Files menu item.

Quit y.Ale Exits the IconEdit program. If you have not saved
the current image, a requester asks if you want to
save the image before exiting lconEdit.
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Edit Menu

The items in the Edit menu allow you to use the Amiga's Clipboard
to import IFF ILBM clips that were created with other programs.

Deletes the image in the magnified view box and
copies it to the Clipboard.

Copies the image in the magnified view box to the
Clipboard.

Copies any image in the Clipboard to the magnified
view box, replacing the current contents.

Erases any image in the magnified view box. You
can erase everything or save before erasing.

Copies an existing IFF file into the Clipboard. A
requester asks for the name of the file to open.
You can then Paste the file into IconEdit.

Saves the current contents in the Clipboard to a
specified file.

Displays the current contents in the Clipboard
using the Display program. To exit Show Clip,
press Ctrl+C. If the Display program is
unavailable, Show Clip cannot work.

The items in the Type menu let you specify the type of icon changed

Cut Alx
Copy 4c
Paste Av
Erase

Open Clip

Save Clip As
Show Clip

Type Menu

or created.

Disk Al
Drawer A2
Tool A3
Project Aa

Garbage Als

Represents the disk icons appearing in the
Workbench window.

Represents the drawer icons appearing in a disk
window, such as the Utilities or Tools drawer.

Represents a tool, such as the Calculator, Clock,
or IconEdit program.

Represents a project, a file that has been created
by a tool, or any of the icons in the Storage
drawer.

Represents the Trashcan drawer.
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Highlight Menu

The items in the Highlight menu let you determine how an icon
appears when it is selected.

Complement 47 Highlights the entire icon, including the background
of the box surrounding the icon. For example, if
you are using the default Workbench colors and
the icon is surrounded by a field of grey, the grey
becomes blue when the icon is selected.

Backfill Als Highlights the icon, but not the background of the
box. For example, if you are using the default
Workbench colors and the icon is surrounded by a
field of grey, the grey remains the same when the
icon is selected.

Image Alo Allows an entirely different image for the selected
icon (a dual image icon). For example, the drawer
icons on the Workbench are dual image. When
you select a drawer, a new image of an open
drawer appears.

Images Menu

The items in the Images menu let you manipulate the images in the
normal and selected view boxes and import IFF images created with
other graphics programs.

Exchange AE Swaps the images that appear in the normal view
and the selected view.

Copy Copy is dependent on the selected radio button. If
Normal is used, the image in the normal view is
copied to the selected view. If Selected is used,
the image in the selected view is copied to the

normal view.
Use Copies a box resembling the standard Workbench
Template icon "tile" into the magnified view. You can then

create your new icon within this box.

Load Loads previously saved images, without changing
the name of the icon being edited. When you point
to the Load menu item, a submenu appears.
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Save Image 4K Saves an image as a picture data type file.

Restore AR Returns the IconEdit window to its state prior to
opening the window or selecting New or Open.

The available Load submenu items are:

Image AJ Allows you to load a data type image file created
by another program as either the normal or
selected view, depending on which radio button is
selected.

When you choose an item from the submenu, a
requester asks you to specify the file to be loaded.
You must specify the correct drawer and filename.

Normal AY Loads the unselected image of the specified icon

Image into the normal or selected view box, depending on
which radio button is selected. (This is equivalent
to dragging an icon into one of the boxes.)

Selected Au Loads the selected image of the specified icon into
Image the normal or selected view box, depending on
which radio button is selected.

Both Images Al| Loads both the normal and selected images of the
specified icon into the appropriate view boxes.

Extras Menu

The items in the Extras menu control additional convenience
features of IconEdit.

Recolor AM Swaps the second and third colors in the color
selection gadget. By default the second color is
black and the third color is white.” Use this to
convert pre-Release 2 icons to the current color
scheme.

Auto ToplLeft AT Moves the image to the upper left corner of the
magnified view box.

Color Palette Opens the Preferences Palette editor to change
the default colors.
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Settings Menu

The items in the Settings menu allow you to save various IconEdit
options.

Use Grid? Use Grid? displays each pixel in the magnified
view box distinctly, with the background color
surrounding it. When Use Grid? is not chosen,
the pixels blend together smoothly. The default
is for the grid to be on.

Create Icons? Create Icons? saves an icon with an IFF Brush
file for the contents of the magnified view box. If
Create Icons? is not chosen, no icon is saved.
The default is for icons to be saved.

Save Settings Save Settings saves all of the current IconEdit
settings, including the size and position of the
IconEdit window, the file requesters, and all of
the menu item settings.

Tool Types
IconEdit supports the following Tool Types:

CLIPUNIT=<n> Specifies the Clipboard unit to use. The default
is 0.

XMAG=<n> Enlarges the width of the magnified view box.
XMAG accepts a number from 4 to 16. The
default is 4.

YMAG=<n> Enlarges the height of the magnified view box.
YMAG accepts a number from 4 to 16. The

~ defaultis 4.

LEFTEDGE=<n> Specifies where to place the left edge of the
editor window.

TOPEDGE=<n> Specifies where to place the top edge of the
editor window.

FRLEFTEDGE=<n> Specifies where to place the left edge of the file

requester, relative to the editor window. For
example, FRLEFTEDGE=0 aligns the left edge
of the file requester with the left edge of the
editor window.
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FRTOPEDGE=<n> Specifies where to place the top edge of the file
requester, relative to the editor window.

FRWIDTH=<n> Specifies the width, in pixels, of the file
requester.

FRHEIGHT=<n> Specifies the height, in pixels, of the file
requester.

PALETTE=<path> Specifies the complete path to the Palette editor

when the Color Palette menu item is chosen.
The default is SYS:Prefs/Palette. Change this
only if you have moved your Palette editor.

SHOWCLIP=<path> Specifies the complete path to the utility used to
display the Clipboard. The default is
SYS:Utilities/Display. If you only have one
floppy drive, copy the Display program onto your
Extras disk and change its path. Change this
Tool Type if you use another program for
displaying the Clipboard.

NOICONS Disables the ability to create icons when saving
support files, such as when saving a file as an
IFF brush.

NOGRID Disables the use of the grid in the magnified
view box.

ICONDRAWER=<path> Specifies the default drawer used by the file
requesters that appear when the Open and Save
As menu items in the Project menu are chosen.

ILBMDRAWER=<path> Specifies the default drawer used by the file
requesters that appear when the Load and Save
IFF Brush menu items in the Images menu are
chosen.

CLIPDRAWER=<path> Specifies the default drawer used by the file
requesters that appear when the Open Clip and
Save As Clip menu items in the Edit menu are
chosen.

ALTDRAWER=<path>  Specifies the default drawer used by the file
requesters that appear when the Load menu
item in the Images menu is chosen.
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CMD (Change Main Device)

CMD directs your printer output to a file rather than to a printer,
capturing output on disk.

To use CMD, Tool Types must be added in the CMD icon's
Information window and you must indicate where to send the
printer output.

The following lists the CMD Tool Types and their recognized
KEYWORDS, arguments, and default.settings.

DEVICE=<port> The Amiga port where your printer is attached, either
parallel or serial. DEVICE=parallel is the default.

FILE=<filename>  The name of the file to which the printer output is
sent. FILE=ram:CMD_file is the default.

SKIP=true Tells CMD to skip any short initial write. The first
write sent to the printer may be a printer reset. You
can use SKIP=true to ignore it. The default is
SKIP=false (initial writes are not skipped).

MULTIPLE=true Tells CMD to redirect more than one file. The default
is MULTIPLE=false (only one file is redirected).

NOTIFY=true Tells CMD to display progress messages. When
CMD intercepts the file, a typical message that may
appear is as follows:

Redirected <# of bytes> from
parallel.device to <filename>

After the output is sent to the file and CMD is turned
off, another message may state:

CMD redirection of parallel.device
removed

The default is NOTIFY=false (messages are not
displayed).

To use CMD, double-click on its icon. The next time information is
sent to your printer, it goes to the designated file instead.
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MEmacs !-';_!

MEmacs (MicroEmacs) is a screen-oriented text editor. A text
editor works the same as a word processor, but it does not support
style formatting options. MEmacs is described in detail in the
Using AmigaDOS manual.

Calculator ﬁ;ﬂ

The Calculator is a standard four-function calculator for adding,
subtracting, multiplying, and dividing. Opening the Calculator icon
activates it.

The calculator works like any standard calculator. The "buttons” on
the calculator are gadgets. The numbered gadgets represent the
digits 0 through 9. The non-numerical gadgets represent:

CA Clear all previous entries. Resets the calculator to 0.
CE Clear the current entry.

X Multiply.

% Divide.

+ Add.

- Subtract.

Decimal point.
« Delete the last digit entered.

+ Change the sign of the current entry. Positive numbers become
negative; negative numbers become positive.
= Display the result of the operation.

To press a button, select the gadget with the mouse or press the
corresponding key on the keyboard. You can use either the
keyboard or numeric keypad keys. On the keyboard Return is
equivalent to the equals (=) button.

The calculator displays a message for Overflow and Divide By Zero
errors.

Select the close gadget to exit the Calculator.
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Calculator menus

The calculator has three menus: the Project menu, the Edit menu,
and the Windows menu.

On the Project menu:

Clear Entry  Clears the current entry only.
Clear All Clears all entries and resets the display to zero.
Quit Turns off the calculator.

On the Edit menu:

Cut Copies and clears the current entry to the Clipboard.

Copy Copies the current entry to the Clipboard without clearing
the area.

Paste Places the current clipboard contents into the calculator.

Show Tape is the only Window menu option. It displays a window
showing the calculator entries and results. Show Tape can also be
copied, but since it does not have a menu, use drag-select and
Amiga+C to copy its contents to the Clipboard.

KeyShow @

The KeyShow program shows the current keymap on your Amiga.
Opening the KeyShow icon displays the default keyboard layout
illustrated in Figure 10-3.
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Figure 10-3. Default KeyShow Window
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The initial display shows the characters that appear when a single
key is pressed. For example, the Q key shows a lower case q.
However, when you press a qualifier key with a character key, you
may get different output. For KeyShow the acceptable qualifer keys
are Ctrl, Shift and both Alt keys.

To see the characters that are output when a quahﬁer key is
pressed simultaneously with a character key:

1. Select any of the qualifer keys that appear in the KeyShow
window. That qualifier key is highlighted.

2. The KeyShow display changes to indicate the output that you
get if you press the selected qualifer key along with a character
key. You can select any combination of quahfers and the
display changes accordingly.

3. Select the qualifier key again to return it to its unpressed state.

Keyboard shortcut: Instead of pointing to the qualifer key in the
display, you can press the corresponding key on the keyboard. The
following list is a guide to interpreting the KeyShow display:

o Qualifier keys not currently pressed are shown in the
Workbench background color (normally grey). For example,
when you first open the KeyShow window, Ctrl, Shift, and Alt
appear in grey. This is because KeyShow is not using those
keys in the initial display.

« Dead keys are shown in the Workbench highlight color
(normally blue). A dead key is one that modifies the output of
the key pressed immediately afterward. For example, on the
USA keyboard, the Alt+G combination is a dead key
representing the grave accent. If you press Alt+G, then press E,
you superimpose the accent symbol over the e (&).

« Bold-italics indicate that a key may be used in conjunction with
a dead key. In the previous example, E can be modified by a
dead key.

e« $$ indicates that it takes more than one character to define the
key.

o Ifacharacter is preceded by a tilde (~) or a caret (*), it is a
control character.

o Blank keys are undefined for the currently selected qualifers.
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GraphicDump @JJ

GraphicDump prints (or dumps) entire screens, including menus
and icons, just as they appear on your monitor. Your printer must
be capable of printing graphic images. (Most printers can print
GraphicDump output.)

Before using GraphicDump, make sure the settings in the Printer,
PrinterPS, and PrinterGfx Preferences editors are appropriate for
your printer. You can specify the dimensions of the printout with
the Limits setting in the PrinterGfx editor. Otherwise, the printout
is the full width allowed by the printer.

To use GraphicDump, double-click on its icon. After a ten second
delay, the front-most screen image is sent to the printer. The mouse
pointer is not printed.

Tool Types

GraphicDump supports a SIZE Tool Type. The acceptable
arguments for SIZE and the resulting size of the printout are:

SIZE=tiny 1/4 the total width allowed by the printer.
SIZE=small 1/2 the total width allowed by the printer.
SIZE=medium 3/4 the total width allowed by the printer.
SIZE=large Full width allowed by the printer (defauit).

The height of the printout maintains the perspective of the screen.
The Limits Type gadget in the PrinterGfx editor must be set to
Ignore for GraphicDump, or else the size of the printout is
determined by the Limits setting.

To set specific dimensions in a Tool Type, use:

SIZE=<xdots>:<ydots>

Substitute the width, in number of printer dots, for the <xdots>
argument and the height for the <ydots> argument.
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InitPrinter ey

InitPrinter sends the printer options specified in the Printer and
PrinterGfx Preferences editors to the printer. It initializes your
printer and loads it with the new or changed specifications when
you turn on the printer and double-click on the InitPrinter icon.

Your printer resets automatically when it receives and processes
initialization information on first access during a session. If you
turn the printer off, you must use InitPrinter to reinitialize it.

PrintFiles ==
PrintFiles sends text files to your printer. It can accept multiple
files selected with drag selection or extended selection. If PrintFiles
cannot find or open one of the files, it skips it and goes to the next
one. The files are printed using the settings specified in the Printer
or PrinterPS Preferences editor.

To use PrintFiles:

1. Select the icon of the first file to be printed, hold down Shift and
select the icons of any additional files to print. You can also use
drag selection to select the icons.

2. Hold down Shift and double-click on the PrintFiles icon.

When printing multiple files, adding a form feed between each file
puts it on a new page. Without a form feed, the next file starts
printing on the same page on which the previous file ends. Add a
form feed with the FORMFEED=true Tool Type in the Printfiles
Information window.

ShowConfig

ShowConfig, illustrated in Figure 10-4, displays system
configuration information, including processor information, custom
chips, software versions, RAM information, and any plug-in boards.
Use this information when requesting hardware/software technical
support.
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Figure 10-4. ShowConfig Window

Lacer

The Lacer program only works when a genlock device is attached to
your Amiga. It toggles the display between interlaced and non-
interlaced mode. This is used primarily for video recording and
genlocking by allowing the Amiga to provide the interlaced input
required by video devices.

PrepCard

The PrepCard utility is used for preparing PCMCIA "credit card”
memory cards. It runs only on Amiga models equipped with a
PCMCIA card slot.

PrepCard prepares standard PCMCIA static RAM cards either as a
disk device or as system RAM. A card prepared as a disk can be
used like a floppy disk: you can read from and write to the card just
as you normally do from applications, the Workbench, or the Shell.
Because the card's memory is battery-backed, the contents of the
card remain when you remove the card or turn off the Amiga. Read
and write operations using memory cards are very fast.

When prepared as system RAM, the card memory is added to the
other memory in the Amiga, as if additional memory were installed
internally. Cards are available in many sizes: from 64 KB to over a
megabyte.

Open the PrepCard window, illustrated in Figure 10-5, by double-
clicking its icon. If a card is inserted, its size and other information
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are displayed. The message FAILED in the Battery display box
indicates that the card's battery has run down and must be replaced
before the card can be used.

. Static RAM '|Disk-like format:
g e | Geonst
) yies —
“ ‘|Bytes/Block : 12
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Sectors/Track & A
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Figure 10-5. PrepCard Window.
PrepCard Display for a 512KB Card Prepared as Disk

You can use PrepCard to prepare cards that are new (unformatted)
or that have been previously prepared as disk or RAM.

1. Select the appropriate gadget, either Prepare as DISK or
Prepare as System RAM. A warning requester appears,
reminding you that any information currently on the card will
be erased if you continue.

2. Select Continue to prepare the card or Cancel to return to the
PrepCard window. Preparation takes only a few seconds.

Note Preparation does not continue if the card is write-
protected. You can flip the write-protect switch to
make it write-enabled without removing the card from
the card slot.

3. Select Quit to exit when you are finished with PrepCard. An
icon for a card you have prepared as a disk immediately
appears, labeled Empty.
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You can work with the card disk as a normal disk, rename it, and
reformat it with the Workbench Format program. A card disk is
device CCO..

To use the memory on a card prepared as system RAM, you must
reboot. (The card must be write-enabled and inserted when you
boot or reboot for its memory to be added to the Amiga's RAM.)
Card memory is added to both Chip (graphics) and Fast (other)
memory.

PrepCard has an Advanced Settings window listed on the menu.
This window allows a variety of low level card configuration
parameters to be altered from the default settings for diagnostic
purposes.

Note Only those with sufficient technical knowledge should
change the default settings in the Advanced Settings
window. Improper settings do not harm the card or
the Amiga, but it can keep the card from functioning

properly.

When using PCMCIA cards, note the following:

o PrepCard does not run if a card is currently in use as RAM. To
run PrepCard again on a card prepared as RAM, insert the card
after booting.

« Removing a card that is currently in use as RAM immediately
reboots the Amiga.

o Do not write-protect a card while it is in use as RAM,; this
causes the Amiga to lock up, requiring you to reboot.

Commodities Drawer

The Commodities drawer, illustrated in Figure 10-6, is in the Tools
drawer and contains the Commodities Exchange programs. These
programs monitor your keyboard and mouse input to the Amiga.
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Figure 10-6. Commodities Window

AutoPoint Automatically activates the window under the pointer.

Blanker Causes the screen to go blank if there has been no
keyboard or mouse activity for a specified period of time.

ClickToFront  Brings a window to the front of the screen by double-

clicking in it.

NoCapslLock Temporarily disables the Caps Lock key.

CrossDOS See Chapter 7.

FKey Assigns special functions to keys.

Mouse Blanker Causes the mouse pointer to go blank when you are
typing.

Exchange Monitors and controls all the other Commodities
programs.

Using Commodities Tool Types

All of the Commodities programs share two common Tool Types:
CX_PRIORITY=<n>, which assigns priorities to the Commodities
Exchange programs, and DONOTWALIT, which instructs the
WBStartup file to continue processing without waiting for the
commodity program to finish. All the programs are set to a default
priority of 0. If you enter a Tool Type that changes the priority to a
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Trouble Shooting

If you encounter problems while using system software, the
following table describes how to resolve them:

Symptom

Cause

Solution

Display is flickering;
screen is not
positioned properly.

A requester asks you

to insert a particular
volume into any
drive.

The wrong display
mode is selected.

The system cannot
find the disk,
partition, or assigned
directory it is looking
for. The disk
containing the
program may have
been removed,
renamed, or an
ASSIGN was not
made.

Open the ScreenMode
editor in the Prefs drawer
and select the appropriate
display mode. If the
screen display is totally
indecipherable, you may
have to reboot with a
different Workbench disk.

Check the volume name
in the requester. Ifitis
the name of a floppy disk
you have removed, insert
that disk. If you have
mistyped a volume name
in a requester or
command, select Cancel,
then enter the correct
name. If the message
appears while the Amiga
is booting, you may need
to add an ASSIGN
statement to your User-
startup file.
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Symptom

Cause

Solution

A requester states
that there is not
enough memory to
load a program.

You cannot move the
pointer and keyboard

input has no effect.

The screen goes
blank and then a
flashing red box
appears stating an
error, such as Not
Enough Memory.

A flashing amber box

appears stating
Recoverable Alert.

You have too many
programs running
and there is not
enough RAM left to
start another
program.

A program has
crashed the Amiga.

Keylock systems
may have lock on.
A program
performed an illegal
action that was
serious enough to
cause a system
failure.

A program
performed an illegal
action that caused
an error from which
the system can
recover.

Close any unnecessary
windows and exit
unnecessary programs.

Reboot.

Turn key to enable
position.

Press the left mouse
button and the computer
reboots.

Press the left mouse
button.
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Screen Display Modes

The following tables list display modes available on the Amiga.

They are grouped according to the Amiga chip set, showing the
possible modes under the original chip set first, followed by those
that require the Enhanced Chip Set, and then those that require the
AA chip set.

To determine if you can use a particular mode, check the horizontal
and vertical scan rates listed in the Mode Properties display against-
the specifications for your monitor. If the display mode's scan rates
are outside your monitor's acceptable range, you cannot use that
mode.

Within the chip set groups, the modes are listed by the monitor file
name that must be in your Devs/Monitors drawer for those modes to
be available in the ScreenMode editor. To use any of the display
modes shown, you must have the full custom chip set required and
the appropriate monitor driver icon must be present in
Devs/Monitors.

Screen Resolution is given in pixels, with the horizontal size
followed by the vertical size. For example, 640 x 400 is a screen 640
pixels wide and 400 pixels high. In the Color Palette column, the
maximum number of displayable colors is given first, followed by a
slash, and then the size of the palette for that mode. For example,
16/4096 is a maximum of 16 displayable colors from a total palette of
4096 colors.
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Monitors Available on Amigas with Original Chip
Set

Note All monitors in this Appendix are available for use
with the AA chip set. On Amigas using the AA chip
set the color palette for all monitors is 256/16 million,
except for A2024 monitors.

NTSC Monitor

Screen Display Mode Screen Resolution Color Palette

" High Res 640 x 200 16 /4096
High Res Laced 640 x 400 16/ 4096

PAL Monitor

Screen Display Mode Screen Resolution  Color Palette

High Res 640 x 256 16 / 4096
High Res Laced 640 x 512 16 /4096

The following are additional display modes that are available under
the original Amiga chip set. These display modes can be used by
applications and the Workbench screen. The Low Res modes are
particularly helpful to users who are visually impaired since they
offer an enlarged display.
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NTSC Monitor

Screen Display Mode  Screen Resolution Color Palette

Low Res 320 x 200 32 /4096

Low Res Laced 320 x 400 32/ 4096

HAM 320 x 200 256,000 / 16 million

HAM Laced 320 x 400 256,000 / 16 million

Extra Halfbrite 320 x 200 64 / 16 million

Extra.HaIfbrite Laced 320 x 400 64 / 16 million
PAL Monitor

Screen Display Mode  Screen Resolution  Color Palette

Low Res 320 x 256 32 /4096

Low Res Laced 320 x 512 32 /4096

HAM 320 x 256 256,000 / 16 million
HAM Laced 320 x 512 256,000 / 16 million
Extra Halfbrite 320 x 256 64 / 16 million

Extra Halfbrite Laced 320 x 512 64 / 16 million
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Monitors Available on Amigas with Enhanced
Chip Set

Note All monitors in this Appendix are available for use
with the AA chip set. On Amigas using the AA chip
set the color palette for all monitors is 256/16 million,
except for A2024 monitors.

The following additional display modes are available for the
Workbench screen on ECS (Enhanced Chip Set) Amiga models:

NTSC Monitor

Screen Display Mode Screen Resolution Color Palette

Super-High Res 1280 x 200 4/64
Super-High Res Laced 1280 x 400 4/64

PAL Monitor

Screen Display Mode Screen Resolution  Color Palette

Super-High Res 1280 x 256 4/64
Super-High Res Laced 1280 x 512 4/64

Multiscan Monitor

Screen Display Mode Screen Resolution Color Palette

Productivity 640 x 480 4/64
Productivity Laced 640 x 960 4/64




Screen Display Modes
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A2024 Monitor

Screen Display Mode

Screen Resolution

Color Palette

10Hz
15Hz

1024 x 800
1024 x 800

4/64
4/64

(On PAL Amigas, A2024 modes have a vertical resolution of 1024.)

Euro36 Monitor

Screen Display Mode

Screen Resolution

Color Palette

Low Res

Low Res Laced

High Res

High Res Laced
Super-High Res
Super-High Res Laced

320 x 200
320 x 400
640 x 200
640 x 400
1280 x 200
1280 x 400

32/ 4096
32/ 4096
16/ 4096
16/ 4096
4/64
4/64

Euro72 Monitor

Screen Display Mode

Screen Resolution

Color Palette

Productivity
Productivity Laced

640 x 400
640 x 800

4/64
4/64
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Screen Display Modes

Super72 Monitor

Screen Display Mode  Screen Resolution Color Palette

High Res 400 x 300 16 /4096

High Res Laced 400 x 600 16 /4096

Super-High Res 800 x 300 4/64

Super-High Res Laced 800 x 600 4/64
Note

If you have an Amiga model with Display Enhancer
circuitry, you should disable the the Display Enhancer
in Super-High Res, Euro36, Euro72, and Super72
modes, to avoid distortion of the display.

A2024 modes require an A2024-style monochrome
monitor. Do not attempt to use an A2024 mode if you
do not have such a monitor.

Monitors Available on Amigas with AA Chip Set

Note

All monitors in this Appendix are available for use

with the AA chip set. On Amigas using the AA chip
set the color palette for all monitors is 256/16 million,
except for A2024 monitors.



Screen Display Modes

The following are display modes that are only available for the

Workbench screen on AA chip set Amiga models:

DBLNTSC Monitor

Screen Display Mode

Screen Resolution

Color Palette

High Res

High Res Laced

High Res Laced No Flicker
Low Res

Low Res Laced

Low Res No Flicker

640 x200
640 x 800
640 x 400
320 x 200
320 x 800
320 x 400

256 / 16 million
256 / 16 million
256 /16 million
256 /16 million
256 / 16 million
256 / 16 million

DBLPAL Monitor

Screen Display Mode

Screen Resolution

Color Palette

High Res

High Res Laced
High Res No Flicker
Low Res

Low Res Laced

Low Res No Flicker

640 x 256
640 x 1024
640 x 512
320 x 256
320 x 1024
320 x 512

256 / 16 million
256 / 16 million
256/ 16 million
256/ 16 million
256 / 16 million
256 /16 million







Appendix C
Special Boot Options

This appendix describes the following special boot options in the
Amiga Early Startup Control system:

« Disabling devices to free memory for large game programs
« Choosing display options for running games
« Diagnosing expansion board failures

The Amiga Early Startup Control Screen, illustrated in Figure C-1,
allows you to select Boot Options, Display Options, or Expansion
Board Diagnostics. Access the Amiga Early Startup Control Screen
by turning on or rebooting your Amiga while holding down both
mouse buttons. You can toggle between NTSC and PAL display
modes by pressing any key on the keyboard, except for the qualifier
keys (Shift, Alt, and Control) and the cursor keys.

(press a key to toggle the display betueen NTSC and PAL)

Boot Options... |

»Displaﬁ Options... |

£ o Expanﬁion Board Diagnostic... |

iRk [ _ Boot Hfth No Startup-Sequence | 4

Figure C-1. Amiga Early Startup Control Screen



c-2 Disabling Devices

Exit the Amiga Early Startup Control screen by selecting the Boot
button for a normal system boot or the Boot with No Startup-
Sequence button to boot directly into an AmigaDOS Shell window.

Disabling Devices

The system software requires additional memory to support the
operation of each hard disk partition or floppy disk drive. The extra
memory that is used to maintain a hard disk or an extra floppy disk
drive can prevent some floppy-based games from running.

Selecting Boot Options from the Amiga Early Startup Control
Screen displays the Boot Options screen, illustrated in Figure C-2.
This screen lets you selectively disable your hard disk partitions
and any external floppy drives to leave enough RAM for the
programs to run correctly.

Select Boot Device - Control fctive Devices
Enabled - - DF8 = - priority 5 - DOSB trackdisk-8

- Enabled - WB_3.x - priority 2- DOSt sesi-6 |

* Enabled " - Work not ,buotahlg;bﬂﬁ' stsi-h o

..‘<> ‘.
>

e e ol o Cgaeet ]

Figure C-2. Boot Options Screen

The Amiga displays a list of hard disk partitions and floppy drives
in the Select Boot Device column. The devices in this column are
listed in descending priority for the system to access when it boots.
You can select any of them to override the priority.

The Control Active devices column shows the status of the devices.
Clicking on the status line toggles between Enabled and Disabled.
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If you are disabling hard drive devices in order to free memory for
games, be sure to leave at least one bootable floppy drive enabled.

Note If your system has more than one floppy drive and the
game lets you use additional drives, you can leave
those drives (DF1, DF2, and DF3) enabled in the
Control Active Devices column on the Boot Options
screen.

Selecting Use implements your boot device choices for the current
session only. When you reboot your Amiga, it returns to the same
configuration as it had before you changed it. Selecting Cancel on
the Boot Options screen cancels any changes you made and returns
to the Amiga Early Startup Control Screen.

Choosing Display Options

Selecting Display Options from the Amiga Early Startup Control

screen displays the Display Options screen, illustrated in Figure

C-3. This screen lets you select the display type and chip set that
your system uses.

C@E NSC ) Oviginal
) PAL ) Enhanced i
o (® Best Available [

li‘s‘e i .‘ hiin : Cancel‘|

Figure C-3. Display Options Screen



Cc-4 Diagnosing Expansion Board Failures

Users with systems containing AA chip sets can choose the Best
Available selection in which the system uses the AA chip set. If a
game or application needs either the original chip set or the
Enhanced Chip Set (ECS) you must select either one for the system
emulate. Users with systems containing the ECS chip set can
emulate the original chip set if selected. This option is ghosted for
users with systems containing only the original chip set.

Diagnosing Expansion Board

Failures

Selecting the Expansion Board Diagnostic option displays the
Expansion Board Diagnostic Screen, illustrated in Figure C-4. This
screen lets you view information about and the status of expansion
boards in your system. If one of your expansion boards fails, this
screen is automatically displayed.

ik 914 3 Horking

" (ontinue | e <

Figure C-4. Expansion Board Diagnostic Screen
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Board Number The number of the expansion board
Manufacturer The number of the maker of the board

Product column The manufacturer's product number for the board
Status column The status of the board: Working or Defective

We recommend providing the manufacturer with this information
when you contact them concerning a failed board.






Glossary

This glossary provides definitions of terms used in the Amiga
- manuals.

acceleration
An option, selected through the Input editor, that causes the
pointer movement to increase as the mouse is moved at a
constant speed. Acceleration provides a higher degree of control
for small mouse movements and less control, but greater mouse
speed, for large movements.

action gadget
A gadget in a window that performs an operation in the window
when you select the gadget. Common action gadgets are Save,
Continue, and Cancel.

active
Currently selected; used in reference to the<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>